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1. Комплекс основных характеристик программы 

 

1.1.Пояснительная записка. 

Дополнительная общеобразовательная общеразвивающая программа 

«Основы промышленного дизайна» (далее – программа) относится к 

программам технической направленности, уровень освоения программы: 

стартовый. Программа предназначена для работы в учреждениях 

дополнительного образования с обучающимися образовательных учреждений, 

желающими овладеть практическими навыками в сфере эскизирования, 3Д 

моделирования, прототипирования.  

Программа разработана в соответствии со следующими нормативными 

документами:  

Федеральный закон от 29 декабря 2012 года № 273-ФЗ «Об образовании в 

Российской Федерации» (ст. 2, ст. 15, ст.16, ст.17, ст.75, ст. 79); 

Распоряжение Правительства Российской Федерации от 31 марта 2022 

года № 678-р об утверждении «Концепции развития дополнительного 

образования детей до 2030 года»; 

Приказ Минпросвещения РФ от 27 июля 2022 года № 629 «Об 

утверждении Порядка организации и осуществления образовательной 

деятельности по дополнительным общеобразовательным программам»; 

Приказ от 30 сентября 2020 г. N 533 «О внесении изменений в порядок 

организации и осуществления образовательной деятельности по 

дополнительным общеобразовательным программам, утвержденный приказом 

Министерства просвещения Российской Федерации от 9 ноября 2018 г. № 

196»; 

Методические рекомендации по проектированию дополнительных 

общеразвивающих программ № 09-3242 от 18.11.2015 года;  

СП 2.4.3648-20 Санитарно-эпидемиологические требования к 

организациям воспитания и обучения, отдыха и оздоровления детей и 

молодежи; 

Письмо Минобрнауки России от 28.08.2015 года № АК – 2563/05 «О 

методических рекомендациях» (вместе с Методическими рекомендациями по 

организации образовательной деятельности с использованием сетевых форм 

реализации образовательных программ); 

Приказ Министерства науки и высшего образования Российской 

Федерации и Министерства просвещения Российской Федерации от 

05.08.2020 г. N 882/391 "Об организации и осуществлении образовательной 

деятельности при сетевой форме реализации образовательных программ»; 

 «Методические рекомендации от 20 марта 2020 г. по реализации 

образовательных программ начального общего, основного общего, среднего 

общего образования, образовательных программ среднего профессионального 

образования и дополнительных общеобразовательных программ с 

применением электронного обучения и дистанционных образовательных 

технологий»; 



4 
 

Устав ОГБПОУ «ДТК»; 

Положение о детском технопарке «Кванториум». 

 

Предметная область программы – дизайна и технологии. Она 

ориентирована на изучение и отработку навыков 3D-моделирования, 

проектирование графических объектов и пространств, и предусматривает 

развитие способностей детей в области пространственного мышления и 

воображения, развивает умение анализировать и критически мыслить, 

понимать процесс пользования и проектирования предметов, процессов и 

среды. 

Обучающиеся получат знания о компьютерных технологиях, о принципах 

и методах проектирования промышленных изделий. Они изучат основы 

композиции, цвета, формы и материалов, а также познакомятся с различными 

техниками и инструментами проектирования. Кроме того, они учатся 

анализировать потребности пользователей и создавать продукты, отвечающие 

этим потребностям. Дети узнают о процессе производства и о том, как дизайн 

может влиять на него.  

Содержание учебных разделов программы направлено на детальное 

изучение алгоритмизации, реализацию межпредметных связей, организацию 

инженерной деятельности обучающихся.  

В программе активно используется проектная, исследовательская и 

инженерная деятельность обучающихся.  

Дополнительная общеразвивающая программа разработана на основе 

специализированной методической литературы и профессионального опыта 

педагога. Программа реализуется с применением высокотехнологичного 

оборудования. 

Актуальность программы обусловлена потребностью общества в 

технически грамотных специалистах в области промышленного дизайна, 

помогает развивать у детей креативное мышление и способность к 

инновациям. В современном быстро меняющемся мире эти навыки становятся 

все более важными, так как они позволяют адаптироваться к новым условиям 

и находить нестандартные решения. 

 Ряд образовательных блоков программы частично решает ключевые 

задачи, определенные для дополнительного образования детей технической 

направленности Концепцией развития дополнительного образования до 2030 

года - это «…вовлечение обучающихся в программы в мероприятия ранней 

профориентации, обеспечивающие ознакомление с современными 

профессиями и профессиями будущего, поддержку профессионального 

самоопределения…». 

Кроме того, промышленный дизайн является одной из перспективных 

профессий будущего, поэтому обучение детей основам этого направления 

может стать хорошим стартом для их будущей карьеры. Поэтому на всех 

этапах реализации программы основной целью является создание интереса у 

детей к творческим и техническим возможностям, формирование потребности 
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в приобретении специальных знаний и навыков для подготовки к осознанному 

выбору профессии.  

Программа является уникальным образовательным продуктом в области 

дизайна и технологий, в рамках которого обучающиеся приобретут 

необходимый навык решения актуальных задач, по разработке и внедрению 

дизайнерского продукта и познакомятся с широким спектром современных 

специальностей, в которых необходимы эти знания.  

 

Новизна и отличительные особенности программы 

Отличительная особенность и ценность программы «Основы 

промышленного дизайна» заключается в ее проектном и практико-

ориентированном подходе к обучению и большим вниманием к 

самостоятельной практической и продуктовой деятельности обучающихся. 

Программа основана на принципах развивающего обучения, способствует 

повышению качества обучения, формированию алгоритмического стиля 

мышления и усилению мотивации к обучению. 

Новизна программы продиктована содержательной частью, которая 

основана на конвергентном подходе в обучении соединяя, взаимозаменяя и 

дополняя в себе ряд отдельных направлений и действий: формирование 

навыков создание эскиза и работа с основными функциями графического 

редактора Adobe Photoshop, отработка базовых навыков 3Д моделирования в 

Blender 3D, изучение и отработка навыков проектирования в программе 

КОМПАС 3D. 

Основу программы составляет метод решения кейсов, который наиболее 

полно отвечает требованиям к формированию практикоориентированных 

компетенций обучающихся.  

В рамках реализации учебного материала в приоритете развитие 

универсальных учебных действий: познавательных, регулятивных, 

личностных и коммуникативных. Компетенции, которые освоят обучающиеся, 

сформируют необходимые теоретические знания и практические навыки для 

различных разработок и воплощения идей и проектов в жизнь с возможностью 

последующей их коммерциализации. 

В ходе реализации программы обучающиеся знакомятся с 

промышленным дизайном, проектированием предметов и сервисов, 

решающих реальные задачи потребителей. Дети самостоятельно решают 

широкий спектр различных задач, что помогает им получить полное 

представление о работе промышленного дизайнера. 

Участие в конкурсных мероприятиях регионального и федерального 

уровня и является одним из основных критериев оценки уровня прохождения 

дополнительной общеразвивающей общеобразовательной программы. 

Обучающиеся представляют на конкурсы, соревнования, олимпиады готовый 

продукт своей деятельности в рамках самостоятельно разработанного и 

реализованного проекта. 
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 Педагогическая целесообразность 

 Педагогическая целесообразность данной программы позволяет решить 

ряд задач. В первую очередь осознанную занятость в свободное от учебы 

время выбранным направлением деятельности.  

В то же время в рамках реализации программы происходит активное 

пробуждение обучающихся к новому виду деятельности. В ходе реализации 

программы происходит формирование и систематизация знаний, развитие 

творческих способностей, воспитание личности с активной жизненной 

позицией, способной самостоятельно ставить перед собой задачи и решать их, 

находя оригинальные способы решения. 

   Дизайн-проектирование, создание прототипов, 3D-моделей формирует 

у обучающихся умение образно и творчески подходить к поставленной задаче, 

а совместная работа в сплоченном коллективе детей, которые ставят перед 

собой единую цель, тесным образом связана с интеллектуальным, 

эмоциональным и нравственным развитием каждого ребенка. 

 Совместная работа в сплоченном коллективе детей, которые ставят перед 

собой единую цель, работая над проектом, тесным образом связана с 

интеллектуальным, эмоциональным и нравственным развитием каждого 

ребенка. 

Педагогическая целесообразность программы заключается в том, что она 

отвечает потребностям общества и образовательным стандартам второго 

поколения в формировании компетентной, творческой личности и 

способствует профессиональному самоопределению в области 

информационных технологий. 

Дополнительность по отношению к программам общего образования 

заключается в том, что она предоставляет ученикам дополнительные знания и 

навыки в области дизайна и технологии, помогает ученикам развить свое 

творческое мышление, улучшить навыки решения проблем и проектирования. 

Она также дает ученикам понимание важности эстетических качеств продукта 

и его функциональности, что является ключевым аспектом промышленного 

дизайна. Таким образом, эта программа дополняет общее образование и 

помогает обучающимся получить необходимые навыки и знания для 

успешной карьеры в будущем. В том числе на занятиях обучающиеся имеют 

возможность применять на практике свои знания, полученные на уроках в 

школе. Например, они могут использовать знания по математике и физике для 

расчета размеров и прочности конструкций, а знания по информатике - для 

создания цифровых моделей и прототипов. Также они могут применять знания 

по истории и культуре для создания продуктов, отражающих определенные 

исторические периоды или культурные традиции. 

Адресат программы. 

Дополнительная общеобразовательная общеразвивающая программа 

«Основы промышленного дизайна» предназначена для обучающихся в 

возрасте от 12 до 17 лет. Группы формируются по 14 человек, состав группы 

постоянный, группы формируются из обучающихся одного возраста, либо 

разновозрастные, по возможности группы 12-15 лет и группы 15-17.  
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В группы принимаются все дети изъявившие желание к занятиям, 

специальных знаний не требуется. 

Программный материал выстроен с учетом возрастных и 

индивидуальных особенностей детей.  

Характеристика возрастной группы 

Программа рассчитана на широкий возрастной диапазон обучающихся: 

12-17 лет. Подростковый период отличается выходом ребенка на качественно 

новую социальную позицию, в которой формируется его сознательное 

отношение к себе как члену общества. Основной формой самопознания 

подростка является сравнение себя с другими людьми — взрослыми, 

сверстниками. Поведение подростка регулируется его самооценкой, а 

самооценка формируется в ходе общения с окружающими людьми. 

Первостепенное значение в этом возрасте приобретает общение со 

сверстниками.  

Особое значение в этом возрасте для ребенка имеет коллектив, 

общественное мнение, оценка сверстниками его поступков и действий. Дети 

стремятся завоевать в глазах сверстников авторитет, занять достойное место в 

коллективе. В этом возрасте у детей проявляется стремление к 

самостоятельности и независимости, возникает интерес к собственной 

личности, формируется самооценка, развиваются абстрактные формы 

мышления. Общаясь со сверстниками, подростки активно осваивают нормы, 

цели, средства социального поведения, вырабатывают критерии оценки себя и 

других, Педагогов воспринимают через призму общественного мнения 

группы. В подростковом возрасте происходит изменение характера 

познавательной деятельности. Подросток становится способным к более 

сложному аналитико-синтетическому восприятию предметов и явлений, 

осуществляется подготовка к профессиональной карьере, обучение нацелено 

на получение профессии. 

В связи с этим основная форма проведения занятий – это практические 

работы, в ходе которых у детей появляется возможность продемонстрировать 

свои индивидуальные способности и коллективные решения поставленных 

задач. 

Все занятия носят познавательный характер, обеспечены техническими 

средствами обучения, что позволяет их адаптировать к конкретному возрасту. 

Объем программы, срок освоения, режим занятий  

Объём программы:144 часа, 9 месяцев. 

Первый модуль – 64 часов, 4 мес. 

Второй модуль – 80 часа, 5 мес. 

Режим занятий: Занятия проводятся 2 раза в неделю по 2 часа. 

 

Особенности организации образовательного процесса. 

Основной формой обучения является комплексное учебное занятие. 

Учебные занятия включают теоретический и практический блок подачи 

учебного материала. Приоритетным методом организации деятельности 
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является практическая деятельность - для отработки навыков работы в 

различных программах, на более поздних этапах - проектная деятельность. 

Основным методом организации учебной деятельности по программе 

является метод кейсов. Кейс - описание проблемной ситуации понятной и 

близкой обучающимся, решение которой требует всестороннего изучения, 

поиска дополнительной информации и моделирования ситуации или объекта, 

с выбором наиболее подходящего.  

Преимущества метода кейсов их практическая направленность. Кейс-

метод позволяет применить теоретические знания к решению практических 

задач и отработать практические навыки программирования в процессе 

решения поставленных задач кейса. 

Кейс-метод обеспечивает более эффективное усвоение материала за счет 

высокой эмоциональной вовлеченности и активного участия обучаемых. 

Участники погружаются в ситуацию с головой: у кейса есть определенная 

задача, которую решает несколько команд. Акцент при обучении делается не 

на овладение готовым знанием, а на его выработку. 

Кейс-метод позволяет совершенствовать конкретные навыки: «гибкие 

навыки» (soft skills), которые оказываются крайне необходимыми в реальном 

рабочем процессе и отрабатывать «жесткие навыки» (hard skills) путем 

тренировки профессиональных навыков в процессе выполнения заданий 

кейса. 

Технология проектирования предусматривает: решение обучающимся 

или группой обучающихся определенной проблемы, либо части проблемы 

(изложенной в задании или кейсе); использование разнообразных методов, 

средств обучения; интегрирование знаний и умений из различных областей 

науки, техники, творчества. Проектная деятельность ориентирована на 

самостоятельную деятельность обучающихся - индивидуальную, парную или 

групповую(командную). 

Формы обучения – очная с применением дистанционных технологий. 

Обеспечению доступности качественной реализации программы 

способствует применение дистанционных образовательных технологий. При 

выборе дистанционных образовательных технологий, учитывается специфика 

программы.  

Для подачи нового программного материала, формирование заданий для 

самостоятельной работы, используются: видеоконференции в Сферум и 

Discord; просмотр заранее записанного педагогом учебного материала; 

просмотр предложенного педагогом готового образовательного 

видеоматериала из сети интернет.  

Самостоятельная практическая работа ведется в программах: Blender 3D – 

отработка навыка 3Д моделирования, Adobe Photoshop – отработка навыков 

скетчинга, создания перспективы, КОМПАС 3D – отработка навыков 

построения чертежа и проектирования 3D.  

Discord представляет собой платформу для конференций, опросов и 

тестов. 
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Обратная связь по контролю пройденного материала, осуществляется 

через мессенджеры Telegram и Сферум. 

 

Программа предусматривает использование следующих форм работы (в 

очном формате): 

фронтальной - подача материала всему коллективу воспитанников; 

индивидуальной - самостоятельная работа обучающихся с оказанием 

педагогом помощи при возникновении затруднения, не уменьшая активности 

обучающегося и содействуя выработки навыков самостоятельной работы; 

групповой - обучающимся предоставляется возможность самостоятельно 

построить свою деятельность на основе принципа взаимозаменяемости, 

ощутить помощь со стороны друг друга, учесть возможности каждого на 

конкретном этапе деятельности. Всё это способствует более быстрому и 

качественному выполнению заданий; 

дистанционной - с применением телекоммуникационных технологий, 

дающих возможность обучающимся освоить объём требуемой информации 

без непосредственного контакта с педагогом. 

Особым приёмом при организации групповой формы работы является 

ориентирование детей на создание команд (минигрупп) или подгрупп с учётом 

их возраста и опыта работы (для отработки специфических навыков, при 

подготовке к фестивалям, конкурсам, выставкам и др.). 

На этапе изучения нового материала используются следующие формы 

обучения: лекции, объяснения, рассказ, демонстрация, игры, консультации. 

На этапе практической деятельности используются формы обучения: 

беседы, дискуссии, практическая работа. 

На этапе освоения навыков используются творческие задания, занятия-

соревнования, воркшоп, подготовка конкурсных работ (рабочая мастерская 

— групповая работа, где все участники активны и самостоятельны). 

На этапе проверки полученных знаний используются формы обучения: 

публичные выступления с демонстрацией результатов работы, дискуссии, 

рефлексия, выставки. 

В процессе обучения по программе используются разнообразные 

педагогические технологии: 

технологии развивающего обучения, направленные на общее целостное 

развитие личности, на основе активно-деятельного способа обучения, 

учитывающие закономерности развития и особенности личности; 

технологии личностно-ориентированного обучения, направленные на 

развитие индивидуальных познавательных способностей каждого ребенка, 

максимальное выявление, раскрытие и использование его опыта; 

технологии дифференцированного обучения, обеспечивающие обучение 

каждого обучающегося на уровне его возможностей и способностей; 

технологии сотрудничества, реализующие демократизм, равенство, 

партнерство в отношениях педагога и обучающегося; 
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проектные технологии - достижение цели через детальную разработку 

проблемы, которая должна завершиться реальным, осязаемым практическим 

результатом, оформленным тем или иным образом; 

компьютерные технологии, формирующие умение работать с 

информацией, исследовательские умения, коммуникативные способности. 

В практике выступают различные комбинации этих технологий, их 

элементов. 

Большое внимание уделяется обеспечению безопасности труда 

обучающихся при выполнении различных работ, в том числе по соблюдению 

правил электробезопасности. 

Реализация воспитательного компонента в рамках дополнительной 

общеразвивающей программы «Основы промышленного дизайна» происходит 

на основании утвержденной «Программы воспитания» детского технопарка 

Кванториум», на основании которой выделен «Воспитательный модуль» 

программы, в котором определены личностные результаты и контрольные 

мероприятия.  

В рамках «Воспитательного модуля» определены и мероприятия, 

направленные на профориентацию (включение в занятия информации о 

профессиях, посещение экскурсии). 

К особенностям организации образовательного процесса можно отнести 

активное сетевое взаимодействие с партнерами по реализации целей 

образовательной программы.  

Заключены Соглашения о сетевом взаимодействии: 

ООО «Торсион-Д» (Приложение 1); 

ООО «Приз» «Центр молодежного инновационного творчества 

«Прогресс» (Приложение 2). 

От каждого партнера определены эксперты, консультанты и наставники, 

встречи с которыми нашли отражение в планах совместной деятельности. 

 

1.2 . Цель и задачи программы 

 

Цель: Создание условий для развития базовых компетенций 

обучающихся в сфере технологий и дизайна, профессионального 

самоопределения и самореализации в процессе организации проектной и 

исследовательской деятельности.  

 

Задачи образовательной программы: 

Обучающие: 

 формировать у детей основы дизайн-мышления в решении и 

постановке творческих аналитических задач проектирования предметной 

среды; 

 формировать у детей организационные умения; 

 научить детей ориентироваться в процессе создания дизайн-

проекта, его основными этапами; 
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 научить детей ориентироваться в задании, планировать и 

контролировать свою работу с помощью педагога;  

 научить детей основам макетирования из простых материалов; 

 формировать практические навыки осуществления процесса 

дизайнерского проектирования, дизайнерского скетчинга, 3D-моделирования 

и прототипирования; 

 ознакомить обучающих с различными видами профессиональных 

компетенций; 

 формировать умение видеть проблемы, формулировать задачи, 

искать пути их решения 

 обучить самостоятельному анализу проделанной детьми 

деятельности (проекта) посредством рефлексии.  

Развивающие: 

 развитие навыков создания эскиза и чертежа; 

 формирование умения практического применения полученных 

знаний; 

 формирование, развитие и совершенствование навыков работы в 

программах 3Д моделированя, графических редакторов; 

 формирование и развитие навыков работы с программами 3D 

моделирования Blender, КОМПАС 3D, графическим редактором Adobe 

Photoshop; 

 развитие у обучающихся интереса к программированию и 

3Dмоделированию; 

 развитие у обучающихся чувства ответственности, внутренней 

инициативы, самостоятельности, тяги к самосовершенствованию; 

 развитие познавательных интересов и формирование 

познавательной активности; 

 развитие творческих способностей и алгоритмического мышления 

у обучающихся; 

 формирование у обучающихся умения работать в команде и 

публично демонстрировать свои проекты; 

 развитие умения визуального представления информации и 

собственных проектов; 

 формирование трудовых умений и навыков, умение планировать 

работу по реализации замысла, предвидеть результат и достигать его, при 

необходимости вносить коррективы в первоначальный замысел. 

 Воспитывающие: 

 формирование активной жизненной позиции, гражданско-

патриотической ответственности; 

 воспитание этики групповой работы, отношений делового 

сотрудничества, взаимоуважения; 

 развитие основ коммуникативных отношений внутри проектных 

групп и в коллективе в целом; 
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 воспитание упорства в достижении результата; 

 пропаганда здорового образа жизни; 

 формирование целеустремлённости, организованности, 

неравнодушия, ответственного отношения к труду, толерантности и 

уважительного отношения к окружающим; 

 совершенствование умения адекватно оценивать и представлять 

результаты совместной или индивидуальной деятельности в процессе 

создания проекта; 

 формировать у обучающихся стремление к получению 

качественного законченного результата. 

 

1.3. Планируемые результаты освоения программы 

Результатом освоения данной программы является формирование soft skills и 

hard skills, а также совершенствование навыков работы с современным 

оборудованием. 

Личностные: 

 формирование ответственного отношения к обучению, готовности и 

способности обучающихся к саморазвитию и самообразованию, средствами 

информационных технологий на основе приобретённой благодаря 

иллюстрированной среде программирования мотивации к обучению и 

познанию; 

 формирование универсальных способов мыслительной деятельности 

(абстрактно-логического мышления, памяти, внимания, творческого 

воображения, умения производить логические операции); 

 формирование коммуникативной компетентности в общении и 

сотрудничестве со сверстниками в процессе образовательной, учебно-

исследовательской деятельности;  

 формирование целостного мировоззрения, соответствующего 

современному уровню развития информационных технологий;  

 формирование осознанного позитивного отношения к другому человеку, 

его мнению, результату его деятельности;  

 формирование ценности здорового и безопасного образа жизни; 

усвоение правил индивидуального и коллективного безопасного поведения 

при работе с компьютерной техникой. 

Метапредметные: 

 ориентироваться в своей системе знаний: отличать новое знание от 

известного;  

 перерабатывать полученную информацию: делать выводы; 

 в результате совместной работы группы, сравнивать и группировать 

полученные результаты;  

 умение планировать, контролировать и оценивать результат 

выполненной самостоятельно и группой работы; 

 умение работать и самостоятельно достигать поставленных задач;  
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 излагать мысли в четкой логической последовательности, отстаивать 

свою точку зрения, анализировать ситуацию и самостоятельно находить 

ответы на вопросы путём логических рассуждений;  

 работать в группе и коллективе. 

Предметные: 

 знание правил безопасного пользования инструментами и 

оборудованием; 

 умение применять оборудование и инструменты; 

 знание принципа работы с программируемыми элементами; 

 знание направлений развития современной науки; 

 знание специфики интерфейсов основных и дополнительных программ; 

 умение разрабатывать эскизы и чертежи в программах Adobe Photoshop 

и КОМПАС 3D; 

 умение проектировать 3d модели в программах для моделирования 

Blender 3d и КОМПАС 3D;  

 знание сферы применения промышленного дизайна; 

 знание профессиональной лексики; 

 знание актуальных направлений научных исследований в общемировой 

практике. 

 

В результате освоения программы обучающиеся должны знать:  

 виды эскизирования и основные особенности создания чертежа;  

 принципы работы приложений для создания 3D моделей;  

 перечень современных устройств, используемых для работы с 

технологиями, и их предназначение;  

 основной функционал программ для трёхмерного моделирования;  

 особенности разработки графических интерфейсов.  

уметь:  

 владение навыками работы различными инструментами в процессе 

изготовления моделей, прототипирования, а также основы работы с 

современным оборудованием;  

 работать с интерфейсом программ для 3D моделирования;  

 применять оборудование для 3Д печати;  

 формулировать задачу на проектирование исходя из выявленной 

проблемы;  

 уметь пользоваться различными методами генерации идей;  

 выполнять примитивные операции в программах для трёхмерного 

моделирования;  

 выполнять примитивные операции в графических редакторах;  

 компилировать приложение для мобильных устройств или 

персональных компьютеров и размещать его для скачивания пользователями;  

 разрабатывать все необходимые графические и видеоматериалы для 

презентации проекта;  
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 представлять свой проект.  

 владеть:  

 основной терминологией в области промышленного дизайна;  

 базовыми навыками трёхмерного моделирования;  

 базовыми навыками работы с интерфейсом графических редакторов и 

приложений 3D моделирования;  

 обладать навыками работы с оборудованием для печати и обработки 

изделий. 

 

1.4. Содержание программы.  

Учебный план. 

№ 

п/п 

Название раздела\темы Количество академических 

часов 

Форма ат-

тестации/ 

контроля Всего Теория Практи

ка 

 Модуль 1. 

 Введение 2 2 0  

 Знакомство, командообразование, 

инструктаж, знакомство с 

оборудованием 

2 2 0 Обсуждение, 

входное 

тестирование 

1. Раздел 1. Основы 

промышленного дизайна 

4 2 2  

1.1 Знакомство с дизайном. 

Формирование идеи. 

2 1 1 Наблюдение  

1.2 Создание макета на основе идеи 2 1 1 Практическое 

занятие 

2. Раздел 2. Основы скетчинга 18 11 7 Обсуждения 

2.1 Изучение основ скетчинга и 

эскизирования 

2 1 1 Практическое 

занятие 

2.2 Построение перспективы на 

бумаге 

2 1 1 Практическое 

занятие 

2.3 Объём. Передача объёма на 

бумаге. 

2 1 1 Практическое 

занятие 

2.4 Материалы. Передача материалов 

на бумаге. 

2 1 1 Практическое 

занятие 

2.5 Построение перспективы в Adobe 

Photoshop 

2 1 1 Практическое 

занятие 

2.6 Объём. Передача объёма в Adobe 

Photoshop 

2 1 1 Практическое 

занятие 

2.7 Материалы. Передача материалов 2 1 1 Практическое 
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в Adobe Photoshop занятие 

2.8 Решение практических задач по 

скетчингу 

4 4 0 Контроль 

3. Раздел 3. Основы 3d-

моделирования (blender) 

14 4 10  

3.1 Принципы создания 3d-моделей, 

виды 3d-моделирования 

2 1 1 Наблюдение 

3.2 Знакомство с blender 2 1 1 Обсуждение 

3.3 Создание простых фигур в 

Blender 

2 0 2 Практическое 

занятие 

3.4 Работа с материалами и 

текстурами 

2 0 2 Практическое 

занятие 

3.5 Создание сложных объектов в 

Blender 

2 1 3 Практическое 

занятие 

3.6 Работа с освещением. Настройка 

камер. Рендер. 

2 1 1 Практическое 

занятие 

 Кейс № 1 «Моделирование 

промдизайнкванта» 

12 3 9  

3.7 Постановка задачи и 

актуализация знаний 

2 1 1 Обсуждение 

 Работа над кейсовым заданием 8 1 6 Практическое 

занятие 

 Создание и защита презентации 

кейса № 1 
2 1 2 Защита  

 Кейс № 2 «Город в blender» 14 2 12  

 Постановка задачи и 

актуализация знаний 

2 1 1 Обсуждение 

 Работа над кейсовым заданием 10 1 9 Практическое 

занятие 

 Создание и защита презентации 

кейса № 2 

2 0 2 Защита 

 Итого 1 модуль  64 24 40  

Модуль 2. 

4 Раздел 4. Работа в программе 

КОМПАС 3D 

30 7 23  

4.1 Основы 3D-моделирования. 

Интерфейс программы КОМПАС 

2 1 1 Практическое 

занятие 

4.2 
Построение простых чертежей 

2 1 1 Практическое 

занятие е 
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4.3 Построение чертежей с 

вспомогательными прямыми  

2 1 1 Практическое 

занятие 

4.4 Построение сложных чертежей 

деталей 3х видов 

4 1 3 Практическое 

занятие е 

4.5 
Практическая работа №1 

6 1 5 Практическое 

занятие 

4.6 Построение 3D деталей по 

чертежам. 

6 1 5 Практическое 

занятие 

4.7 
Практическая работа №2 

6 1 5 Практическое 

занятие е 

4.8 Итоговая практическая работа 2 0 2 Контроль 

5. Раздел 5. Кейс №3 Photoshop + 

Анимация в Blender 

 

22 4 18  

5.1 Постановка задачи и 

актуализация знаний 

2 1 1 Наблюдение 

5.2 Работа над кейсовым заданием 18 3 15 Практическое 

занятие 

5.7 Создание и защита презентации 

кейса № 3 

2 0 2 Защита 

6 Раздел 6. Кейс №5 Работа со 

сложной моделью 

28 4 24  

6.1 Создание чертежа модели в 

КОМПАС 

4 1 3 Обсуждение, 

тестирование 

6.2 Создание 3D модели в КОМПАС  4 1 3 Наблюдение 

6.3 Работа с 3D печатью 6 1 5 Наблюдение 

6.4 Сборка и покраска прототипа 4 1 4 Практическое 

занятие 

6.5 Доработка проекта 4 0 4 Практическое 

занятие 

6.6 Разработка проектной подачи и 

презентации 

4 0 4 Практическое 

занятие е 

6.7 Представление и защита своего 

проекта 

2 0 2 Презентация 

проектной идеи 

 Итого 2 модуль  50 8 42  

  144 39 105  
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Содержание программы 

Модуль 1 (64 часа) 

Занятие № 1. Введение (2 часа) 

Знакомство, командообразование, инструктаж, знакомство с 

оборудованием 

Теория: Знакомство с обучающимися, сбор и корректировка ожиданий 

Техника безопасности. Входящая диагностика. Ознакомление с принципами 

взаимодействия внутри группы. Работа в команде, игры на 

командообразование. Эффективное распределение задач при осуществлении 

командной работы. Принципы и виды презентации результатов своей работы.  

Практика: игры на знакомство, игра на генерацию идей «вСмысле». 

Раздел 1. Основы промышленного дизайна. (4 часов) 

Занятие № 2. Знакомство с дизайном. Формирование идеи. (2 часа) 

Теория: Пример условия из будущего в социальной сфере: к 2080 году 

две трети населения Земли будут проживать в мегаполисах. 

Пример условия из будущего в технологической сфере: к 2080 году будет 

разработана технология парообразного питания. Опираясь на эти условия, 

нужно создать карту ассоциаций (MindMap). 

Практика: Педагог разбивает обучающихся по группам, состоящих из 

двух человек. Каждая группа выбирает два условия из будущего - социальной 

сфере и в сфере развития технологий. Опираясь на эти условия нужно создать 

карту ассоциаций (MindMap). Причём в каждом последующем внешнем круге 

ассоциации к словам из предыдущего круга. Таким образом появляется 

многоуровневый набор ассоциаций. На основе одной или нескольких 

ассоциаций из этой карты формируется идея нового продукта, помогающего 

существовать человеку в заданных в начале проекта условиях. В конце 

занятия каждая группа выступает с презентацией своей идеи.  

Занятие № 3. Создание макета на основе идеи(2 часа) 

Теория: Знакомство с материалами, этапы создания макета из подручных 

материалов. Основы макетирования.  

Практика: Создание объекта, придуманного на прошлом занятии, 

выполненного по существующим технологиям, собранного из ненужных 

предметов настоящего. Объекты можно упаковать и сделать ценник, как для 

продажи в магазине. 

 

Раздел 2. Основы скетчинга (18 часов) 

 

Занятие № 4. Изучение основ скетчинга и эскизирования (2 часа) 

Теория: Знакомство с основами скетчинга, понимание где применяется 

скетчинг, виды эскизирования. 

Практика: Создание пробного эскиза на основе имеющихся изучений и 

навыков. 

Занятие № 5. Построение перспективы на бумаге (2 часа) 
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Теория: Изучение перспективы, линии, построение окружности и других 

фигур в перспективе, композиция.  

 Практика: Обучающие строят простой бытовой предмет (стул, пеналит, 

шкаф) в нескольких вариантах перспективы.  

Материал для самостоятельного изучения:  

https://rutube.ru/video/dc4cfcc9ce75f57f3e0a37b8ed1876b0/?ysclid=lvb80a28

dd758526651 

Занятие № 6. Построение объема на бумаге (2 часа) 

Теория: правила перспективного построения объёмных форм, 

обучающиеся изучают светотень и падающую тень на примере гипсовых 

фигур. Далее наставник демонстрирует технику рисунка маркерами. 

Практика: Добавление объема с помощью карандашей и маркеров на 

объект. 

Занятие № 7. Материалы. Передача материалов на бумаге  

Теория: изучение передачи материала на бумаге, текстуры, инструменты 

для правильной передачи материала. 

Практика: доработка построения бытового предмета и передача 

материала  

Занятие № 8. Построение перспективы в Adobe Photoshop  

Теория: Изучение интерфейса программы Adobe Photoshop.  

Практика: Самостоятельное изображение перспективы в редакторе с 

помощью графического планшета. 

Материал для самостоятельного изучения к блоку:  

https://rutube.ru/video/6f6b932a94ecbd270351acccb9a34c86/?ysclid=lvb846hi

52628635509 

Занятие № 9. Объём. Передача объёма в Adobe Photoshop (2 часа) 

Теория: Работа с кистями в графическом редакторе. Передача объема с 

помощью различных инструментов программы Adobe Photoshop. 

Практика: Создание объектов и отображения различных сценариев 

освещения, объема, света и тени в редакторе с помощью графического 

планшета.  

Занятие № 10. Материалы. Передача материалов в Adobe Photoshop 

(2 часа) 

Теория: Работа со слоями и объемными кистями. 

Практика: Создание эскиза бытового предмета, затем передача 

материала на эскизе бытового предмета. 

Занятие №№ 11,12. Решение практических задач по скетчингу (4 

часа) 

Практика: Практические упражнения по генерации идеи и созданию 

скетча предмета интерьера в графическом редакторе, передача материалов, 

объема и текстур. 

Контроль: итоговое тестирование. 

 

Раздел 3. Основы 3d-моделирования (blender)(14 часов) 

https://rutube.ru/video/dc4cfcc9ce75f57f3e0a37b8ed1876b0/?ysclid=lvb80a28dd758526651
https://rutube.ru/video/dc4cfcc9ce75f57f3e0a37b8ed1876b0/?ysclid=lvb80a28dd758526651
https://rutube.ru/video/6f6b932a94ecbd270351acccb9a34c86/?ysclid=lvb846hi52628635509
https://rutube.ru/video/6f6b932a94ecbd270351acccb9a34c86/?ysclid=lvb846hi52628635509
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Занятие №13. Принципы создания 3d-моделей, виды 3d-

моделирования (2 часа) 

Теория: Изучение видов 3d моделирования, программы для 

моделирования, каркасное и твердотельное моделирование. 

Практика: Прототипирование с помощью 3d ручки 

Занятие №14. Знакомство с blender (2 часа) 

Теория: Основы 3d моделирования. Применение 3d моделирования в 

промышленном дизайне.  

Практика: знакомство с интерфейсом программы для 3d моделирования 

Материал для самостоятельного изучения: 

https://rutube.ru/video/39f5e8fc811e648427fe08c8b30c01e8/?ysclid=lvb85yirwd39

0244954 

Занятие №15. Создание простых фигур в Blender (2 часа) 

Практика: Создание объектов из простых готовых фигур, перемещение 

и масштабирование  моделей. Практические упражнения по созданию 

низкополигональных моделей. Разработка и создание моделей с небольшим 

количеством полигонов. 

Занятие №16. Работа с материалами и текстурами 

Практика: Применение практических знаний и создание простых 

объектов, наложение встроенных текстур и различных материалов на модель. 

Занятие №№17,18. Создание сложных объектов в Blender (4 часа) 

Теория: Добавление объектов на сцену, модификатор скругления граней, 

экструдирование, копирование с помощью array/ 

Практика: Применение практических знаний и создание 

высокополигональных моделей, состоящих из нескольких объектов. 

Наложение материала, применение функции экструдирования, моделирование 

с помощью готовых ассетов. 

Материал для самостоятельного изучения: 

https://rutube.ru/video/045f2ef6b77204501df9eaa6cda41460/?ysclid=lvb8t4217358

4616893 

Занятие № 19. Работа с освещением. Настройка камер. Рендер (2 

часа) 

Практика: Применение теоретических знаний о типах и форматах 

файлов, принципах работы с ними, общей логики и принципах создания и 

отрисовки изображения на компьютере, цветовых схемы, понятия рендера при 

решении практических задач. Работа над моделями, повышение уровня 

реалистичности созданных моделей. 

Занятие №№ 20-25. «Моделирование промдизайнкванта». Кейс № 1. 

(12 часов). 

Занятие № 20. Постановка задачи и актуализация знаний (2 часа) 

Теория: Информация о кейсе, структуре и его содержании.  

Практика: Моделирование интерьера кванта с помощью примитивов. 

Создание мебели, рабочих столов, стульев, компьютеров, сценариев 

освещения и рабочих зон. Для построения модели использовать Mesh-

https://rutube.ru/video/39f5e8fc811e648427fe08c8b30c01e8/?ysclid=lvb85yirwd390244954
https://rutube.ru/video/39f5e8fc811e648427fe08c8b30c01e8/?ysclid=lvb85yirwd390244954
https://rutube.ru/video/045f2ef6b77204501df9eaa6cda41460/?ysclid=lvb8t42173584616893
https://rutube.ru/video/045f2ef6b77204501df9eaa6cda41460/?ysclid=lvb8t42173584616893
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объекты, команды модификации «G»- перемещение, «S»- масштабирование, 

«R»- вращение. 

Занятие № 21. Работа над кейсовым заданием (2 часа) 

Практика: Разработка проекта модели промдизайнкванта, детализация 

интерьера. 

Подготовка к конкурсам. Индивидуальная работа. Региональный 

конкурс «3D игрушка».  

Занятие № 22. Работа над кейсовым заданием (2 часа) 

Практика: Разработка проекта модели промдизайнкванта, детализация 

интерьера. 

Подготовка к конкурсам. Индивидуальная работа. Региональный 

конкурс «3D игрушка».  

Занятие № 23. Работа над кейсовым заданием (2 часа) 

Практика: Разработка проекта модели промдизайнкванта, детализация 

интерьера. 

Занятие № 24. Работа над кейсовым заданием (2 часа) 

Практика: Настройка освещения, настройка камер, рендер. Работа над 

моделями, повышение уровня реалистичности созданных моделей. Создание 

презентации для защиты проекта. 

Занятие № 25. Создание и защита презентации кейса № 1 (2 часа) 

Теория: Разработка проектной презентации. 

Материал для самостоятельного изучения: 

https://rutube.ru/video/1076a5b417148838a7d50fc8c3ec487d/?r=a  

Практика: Доработка презентации и защита кейса №1. 

Занятие №№ 26-32. «Город в blender». Кейс № 2. (14 часов). 

Занятие № 26. Постановка задачи и актуализация знаний (2 часа) 

Теория: Информация о кейсе, структуре и его содержании.  

Практика: Определения районов города для создания новых локаций, 

создание парковых зон, зон отдыха для жителей города и домашних 

животных, реконструкция исторических объектов города и создание моделей 

новых зданий.  

Занятие № 27. Работа над кейсовым заданием (2 часа) 

Практика: Разработка проекта моделей локаций города, детализация 

объектов. 

Занятие № 28. Работа над кейсовым заданием (2 часа) 

Практика: Разработка проекта моделей локаций города, детализация 

объектов. 

Подготовка к конкурсам. Индивидуальная работа. Всероссийский 

конкурс проектов 3D моделирования и 3D печати «Перспектива 3D» 

Занятие № 29. Работа над кейсовым заданием (2 часа) 

Практика: Разработка проекта моделей локаций города, детализация 

объектов. 

Подготовка к конкурсам. Индивидуальная работа. Всероссийский 

конкурс проектов 3D моделирования и 3D печати «Перспектива 3D» 

Занятие № 30. Работа над кейсовым заданием (2 часа)  

https://rutube.ru/video/1076a5b417148838a7d50fc8c3ec487d/?r=a


21 
 

Практика: Разработка проекта моделей локаций города, детализация 

объектов. 

Подготовка к конкурсам. Индивидуальная работа. Всероссийский 

конкурс проектов 3D моделирования и 3D печати «Перспектива 3D» 

Занятие № 31. Работа над кейсовым заданием (2 часа) 

Теория: Работа с освещением  

Практика: Настройка освещения, настройка камер, рендер. Работа над 

моделями, повышение уровня реалистичности созданных моделей. Создание 

презентации для защиты проекта.  

Занятие № 32. Создание и защита презентации кейса № 2 

Практика: Структура и содержание презентации. Доработка презентации 

и защита кейса №2. 

 

Раздел 4. Работа в программе КОМПАС 3D (30 часов) 

Занятие № 33. Основы 3D-моделирования. Интерфейс программы 

КОМПАС (2 часа) 

Теория: Основы инженерного 3D моделирования, примеры применение 

инженерного моделирования на практике. 

Практика: Знакомство с интерфейсом программы КОМПАС 3D. 

Занятие № 34. Построение простых чертежей (2 часа) 

Теория: Изучение основ построения чертежа, начертание линий.  

Практика: Построение упрощенных графических объектов по заданным 

размерам. 

Занятие №35. Построение чертежей с вспомогательными прямыми (2 

часа) 

Теория: Основы работы в программе КОМПАС 3D с основными 

объектами 

Практика: Работа в программе КОМПАС 3D, измерение и построение 

чертежа рабочей зоны с помощью вспомогательных прямых по заданным 

размерам.  

Материал для самостоятельного изучения: 

https://rutube.ru/video/d1f991bf47e422886f804a0b3b080010/ 

https://rutube.ru/video/095b3c9b3a5142ebb1ab147535446aeb/ 

Занятие №№36,37. Построение сложных чертежей деталей 3х видов (4 

часа) 

Теория: Изучение видов чертежа, плоскости проекции фронтальная, 

горизонтальная, профильная. Изометрия на чертеже. 

Практика: Самостоятельное построение чертежа объектов в трех 

плоскостях по заданным размерам. Необходимо построить чертежи объекта 

(предметы мебели, деталь автомобиля, рабочая зона, компьютер, 3d принтер 

или другие объекты). 

Занятие №№38,39, 40. Практическая работа №1. (6 часов) 

Теория: Информация о практической работе, структура и содержание 

работы. 

https://rutube.ru/video/d1f991bf47e422886f804a0b3b080010/
https://rutube.ru/video/095b3c9b3a5142ebb1ab147535446aeb/
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Практика: построение чертежа реальной детали. Проведение замеров 

детали, построение чертежа 3х видов по результатам замера. Дальнейшее 

построение чертежа в изометрии. 

Занятие №№41,42,43. Построение 3D деталей по чертежам. (6 часов) 

Теория: работа с интерфейсом программы для создания 3д моделей, 

принципы эскизирования в программе КОМПАС. 

Практика: построение детали по заданным чертежам, добавление фасок, 

технических отверстий, соединение деталей друг с другом.  

Занятие №№44,45,46. Практическая работа №2 (6 часов) 

Теория: Информация о практической работе, структура и содержание 

работы.  

Практика: Проведение замеров детали, самостоятельное построение 3D 

модели на основе теоретических и практических знаний, основываясь на 

результаты замера 

Занятие №47. Итоговая практическая работа (2 часа) 

1. С помощью измерительных приборов произведите замеры обрасти для 

создания недостающей детали. 

2. На основе полученных расчетов разработайте чертеж детали и 

выполните эскиз в программе КОМПАС. 

3. Выполните твердотельное моделирование по готовому эскизу. 

Практика: На основе теоретических и практических знаний, полученных 

в ходе занятий, самостоятельно разработать чертеж, эскиз и построить 3d 

модель. 

Контроль: итоговое тестирование. 

 

Раздел 5. «Photoshop + Анимация в Blender» (Кейс №3) (22 часа) 

Занятие № 48. Постановка задачи и актуализация знаний (2 часа) 

Теория: Информация о кейсе, структуре и его содержании. Понятие 

анимации. Изучение покадровой анимации в blender. 

Практика: Выбор объекта моделирования, постановка задачи, 

разработка эскиза будущей 3d модели в графическом редакторе Photoshop. 

Создание 3d модели и поэтапная анимация. Фиксация кадра, основы работы с 

таймлайном и нодами. 

Занятие №№ 49,50. Работа над кейсовым заданием (4 часа) 

Теория: Способы анимации, меню ключевых кадров, использование 

сцены и компоновки объектов. 

Практика: Разработка проекта, доработка эскиза, создание 3d модели. 

Занятие № 51-53. Работа над кейсовым заданием (6 часов) 

Теория: Понятие ключевого кадра, временная шкала, 

Практика: Разработка проекта, работа с ассетами и создание сцены, 

доработка 3d модели, анимация полученной модели. 

Занятие № 55-57. Работа над кейсовым заданием (6 часов) 

Теория: Изменение формы объекта, циклическое перемещение, 

перемещение по траектории. Работа над расположением информации для 

презентации. 
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Практика: Доработка анимации модели и создания презентации для 

защиты кейса №3. 

Занятие № 58. Создание и защита презентации кейса №3 (2 часа) 

Практика: Доработка презентации и защита проекта кейса №3 

 

Раздел 6. Работа со сложной моделью. Кейс №5 (14 часов) 

Занятие №№ 59, 60. Создание чертежа модели в КОМПАС (2 часа) 

Теория: Информация о кейсе, структуре и его содержании. 

Практика: Создание чертежа модели для итоговой защиты в программе 

КОМПАС  

Занятие № № 61, 62. Создание 3D модели в КОМПАС (4 часа) 

Теория: Изучение процесса создания 3d моделей состоящую из 

нескольких компонентов с шарнирным соединением. 

Практика: Создание 3d моделей состоящую из нескольких компонентов 

с шарнирным соединением в программе КОМПАС  

Занятие №№63, 64, 65. Работа с 3D печатью (6 часа) 

Теория: Основы работы на 3d принтере, работа в программе ultimaker 

cura, подготовка моделей к печати. 

Практика: Создание моделей на специализированном оборудовании. 

Печать с помощью 3D принтере.  

Занятие №№ 66, 67. Сборка и покраска прототипа (4 часа) 

Теория: Разновидность материалов, работа инструментами для 

обработки поверхностей различных материалов, техника безопасности при 

работе.  

Практика: Сборка прототипа из отдельных частей 

Занятие №№ 68, 69. Доработка проекта (4 часа) 

Практика: Сборка прототипа из составных частей, покраска,  

Занятие №№ 70, 71. Разработка проектной подачи и презентации (4 

часа) 

Практика: Импорт моделей в сцену, создание проекта, финализация 

сцены, настройка качества картинки, оптимизация сцены, добавление 

интерактивных элементов. Использование готовых моделей для создания 

сцен.  

Занятие № 72. Представление и защита своего проекта (2 часа) 

Практика: Демонстрация навыков презентации результатов 

выполненного кейса. Итоговая защита проекта. 
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2.Комплекс организационно-педагогических условий. 

2.1.Календарно - учебный график 

№ 

П\п 

Ме

ся

ц 

Чис

ло 

Время 

проведе

ния 

занятия 

Форма 

занятия 

Кол-во 

часов 

Тема занятия Место 

проведен

ия 

Форма 

контроля 

Введение 

1     2 Знакомство, 

командообразование, 

инструктаж, знакомство 

с оборудованием 

Промдиз

айн -

квантум 

Обсуждение 

Входной 

контроль 

(тестировани

е) 

Раздел 1. Основы промышленного дизайна 

2     2 
Знакомство с дизайном. 

Формирование идеи. 

Промдиз

айн -

квантум 

Обсуждение 

3     2 
Создание макета на 

основе идеи 

Промдиз

айн -

квантум 

Практическо

е задание 

Раздел 2. Основы скетчинга 

4     2 Изучение основ 

скетчинга и 

эскизирования 

Промдиз

айн -

квантум 

Обсуждения 

5     2 
Построение 

перспективы на бумаге 

Промдиз

айн -

квантум 

Практическо

е занятие 

6     2 
Объём. Передача 

объёма на бумаге. 

Промдиз

айн -

квантум 

Практическо

е занятие 

7     2 
Материалы. Передача 

материалов на бумаге. 

Промдиз

айн -

квантум 

Практическо

е занятие 

8     2 Построение 

перспективы в Adobe 

Photoshop 

Промдиз

айн -

квантум 

Практическо

е занятие 

9     2 Объём. Передача 

объёма в Adobe 

Photoshop 

Промдиз

айн -

квантум 

Практическо

е занятие 

10     2 Материалы. Передача 

материалов в Adobe 

Photoshop 

Промдиз

айн -

квантум 

Практическо

е занятие 
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11     2 
Решение практических 

задач по скетчингу 

Промдиз

айн -

квантум 

Практическо

е занятие 

12     2 
Решение практических 

задач по скетчингу 

Промдиз

айн -

квантум 

Контроль 

Раздел 3. Основы 3d-моделирования (blender) 

13     2 Принципы создания 3d-

моделей, виды 3d-

моделирования 

Промдиз

айн -

квантум 

Наблюдение 

14     2 

Знакомство с blender  

Промдиз

айн -

квантум 

Обсуждение 

15     2 
Создание простых 

фигур в Blender 

Промдиз

айн -

квантум 

Практическо

е занятие 

16     2 
Работа с материалами и 

текстурами 

Промдиз

айн -

квантум 

Практическо

е занятие 

17     2 Создание сложных 

объектов в Blender 

Промдиз

айн -

квантум 

Практическо

е занятие 

18     2 
Создание сложных 

объектов в Blender 

Промдиз

айн -

квантум 

Практическо

е занятие 

19     2 Работа с освещением. 

Настройка камер. 

Рендер. 

Промдиз

айн -

квантум 

Практическо

е занятие 

 Кейс № 1 «Моделирование промдизайнквантума» 

20     

2 
Постановка задачи и 

актуализация знаний 

Промдиз

айн -

квантум 

Обсуждение 

21     

2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие 

22     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие 

23     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие  
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24     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие 

проекта 

25 

 

    2 
Создание и защита 

презентации кейса № 1 

Промдиз

айн -

квантум 

Защита 

Кейс № 2 «Город в blender» 

26     2 
Постановка задачи и 

актуализация знаний 

Промдиз

айн -

квантум 

Обсуждение 

27     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие 

28     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие 

29     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие е 

30     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие 

31     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие е 

32     2 Создание и защита 

презентации кейса № 2 

Промдиз

айн -

квантум 

Защита 

Раздел 4. Работа в программе КОМПАС 3D 

33     2 Основы 3D-

моделирования. 

Интерфейс программы 

КОМПАС 

Промдиз

айн -

квантум 

Обсуждение, 

наблюдение 

34     

2 
Построение простых 

чертежей 

Промдиз

айн -

квантум 

Практическо

е занятие 

35     

2 

Построение чертежей с 

вспомогательными 

прямыми  

Промдиз

айн -

квантум 

Практическо

е занятие 

36     

2 

Построение сложные 

чертежей деталей 3х 

видов 

Промдиз

айн -

квантум 

Практическо

е занятие 
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37     

2 

Построение сложные 

чертежей деталей 3х 

видов 

Промдиз

айн -

квантум 

Практическо

е занятие 

38     

2 
Практическая работа 

№1 

Промдиз

айн -

квантум 

Практическо

е занятие 

39     

2 

Практическая работа 

№1 

Промдиз

айн -

квантум 

Практическо

е занятие 

40     

2 
Практическая работа 

№1 

Промдиз

айн -

квантум 

Практическо

е занятие 

41     

2 
Построение 3D деталей 

по чертежам. 

Промдиз

айн -

квантум 

Практическо

е занятие 

42     

2 
Построение 3D деталей 

по чертежам. 

Промдиз

айн -

квантум 

Практическо

е занятие 

43     

2 

Построение 3D деталей 

по чертежам. 

Промдиз

айн -

квантум 

Презентация 

проектной 

идеи 

44     2 
Практическая работа 

№2 

Промдиз

айн -

квантум 

Практическо

е занятие 

45     2 
Практическая работа 

№2 

Промдиз

айн -

квантум 

Практическо

е занятие 

46     2 
Практическая работа 

№2 

Промдиз

айн -

квантум 

Практическо

е занятие 

47     2 
Итоговая практическая 

работа 

Промдиз

айн -

квантум 

Практическо

е занятие 

Раздел 5. Кейс №3 PhotoShop + Анимация в Blender 

48     2 
Постановка задачи и 

актуализация знаний  

Промдиз

айн -

квантум 

Обсуждение  

49     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Наблюдение 

50     2 Работа над кейсовым 

заданием 

Промдиз

айн -

Обсуждение  
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квантум 

51     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие 

52     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Защита 

53     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие  

54     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие 

55     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие 

56     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие 

57     2 
Работа над кейсовым 

заданием 

Промдиз

айн -

квантум 

Практическо

е занятие 

58     2 
Создание и защита 

презентации кейса №3  

Промдиз

айн -

квантум 

Практическо

е занятие 

Раздел 6. Кейс №5 Работа со сложной моделью  

59     2 
Создание чертежа 

модели в КОМПАС 

Промдиз

айн -

квантум 

Обсуждение, 

тестирование 

60     2 Создание чертежа 

модели в КОМПАС 

Промдиз

айн -

квантум 

Презентация 

проектной 

идеи. 

61     2 Создание 3D модели в 

КОМПАС  

Промдиз

айн -

квантум 

Наблюдение 

62     2 Создание 3D модели в 

КОМПАС  

Промдиз

айн -

квантум 

Наблюдение 

63     2 Работа с 3D печатью Промдиз

айн -

квантум 

Наблюдение 
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64     2 Работа с 3D печатью Промдиз

айн -

квантум 

Практическо

е занятие 

65     2 Работа с 3D печатью Промдиз

айн -

квантум 

Практическо

е занятие 

66     2 Сборка и покраска 

прототипа 

Промдиз

айн -

квантум 

Практическо

е занятие 

67     2 Сборка и покраска 

прототипа 

Промдиз

айн -

квантум 

Практическо

е занятие 

68     2 Доработка проекта Промдиз

айн -

квантум 

Практическо

е занятие 

69     2 Доработка проекта Промдиз

айн -

квантум 

Практическо

е занятие 

70     2 Разработка проектной 

подачи и презентации 

Промдиз

айн -

квантум 

Практическо

е занятие 

71     2 Разработка проектной 

подачи и презентации 

Промдиз

айн -

квантум 

Практическо

е занятие 

72     2 Представление и защита 

своего проекта.  

Промдиз

айн -

квантум 

Практическо

е занятие 

 

2.2. Условия реализации программы 

Успешность реализации программы в значительной степени зависит от 

уровня квалификации преподавательского состава и материально - 

технического обеспечения. 

Требования к педагогическому составу: 

- Среднее профессиональное педагогическое с техническим уклоном 

(техническое) или высшее педагогическое (техническое) образование по 

направлениям (информатика, математика, физика, администрирование 

информационных систем, компьютерная безопасность, радиоэлектроника).  

- Опыт работы и навыки преподавания в режиме проектной деятельности.  

2.2.1. Материально-техническое обеспечение 

Требования к материально - техническому обеспечению: основными 

условиями реализации программы являются наличие кабинета, отвечающего 

нормам охраны труда, техники безопасности, пожарной и электробезопасности, 

санитарным и гигиеническим требованиям, мебели (рабочий стол, стулья, 

рабочее место педагога), оборудование. 
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Учебная аудитория для проведения практических занятий, оснащенная 

мебелью на 14 посадочных мест, компьютерной техникой, не менее 1 ПК на 1 

обучающегося. 

Рекомендуемое учебное оборудование, рассчитанное на группу из 14 

человек: 
№ 

п/п 

Наименование  Кол-во 

1 3D-принтер 2 

2 3D-принтер с двумя экструдерами 1 

3 3D сканер 1 

4 3D сканер ручной 1 

5 3D ручка 15 

6 Терморежущий станок  1 

7 Набор для скетчинга 15 

8 Коврики для резки бумаги А3 15 

9 Набор инструментов (напильники, надфиля, ножи макетные, ножницы 

Клеевой пистолет, Линейка металлическая) 

14 

10 Цифровой зеркальный фотоаппарат 1 

11 МФУ А3/А4 (принтер, сканер, копир) 1 

12 Стационарный компьютер 15 

13 Монитор  15 

14 Графический планшет тип 1 15 

15 Графический планшет тип 2 5 

16 Портативный проектор  1 

17 Ноутбук 1 

18 Шлем виртуальной реальности 2 

19 Стойка для внешних датчиков 4 

20 Флипчарт 1 

21 Моноблочное интерактивное устройство  1 

22 Напольная мобильная стойка для интерактивных досок или 

универсальное настенное крепление 

1 

23 Столы для компьютеров и планшетов 14 

24 Столы для рисования 8 

25 Стулья 21 

26 Настольный светильник  15 

27 Стеллажи 770х1500 2 

28 Тумба под принтер 2 

29 Магнитно-маркерная доска 1 
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2.3. Формы аттестации и критерии результативности обучения. 

 

Процесс обучения по дополнительной общеобразовательной 

общеразвивающей программе предусматривает следующие формы диагностики 

и аттестации.  

Входная диагностика, проводится перед началом обучения и 

предназначена для выявления уровня подготовленности детей к усвоению 

программы. Формы контроля: беседа, опрос, тестирование. 

Оценка входной диагностики производится по трём уровням: «высокий», 

«средний» и «низкий». 

Промежуточная аттестация. Проводится по завершении изучения 

каждого блока программы.  

Формы контроля: тестирование, практическое задание и презентация 

проекта, защита проекта, участие в конкурсах (конкурсная работа). 

Предметом диагностики и контроля являются образовательные проектные 

продукты обучающихся (созданные программы, решение кейсовых задач, 

приобретенные навыки работы в программах), а также их внутренние 

личностные качества (освоенные способы деятельности, знания, умения), 

которые относятся к целям и задачам блоков программы. 

Промежуточной аттестации проводится в присутствии эксперта, 

определенного в рамках реализации сетевого взаимодействия.  

Оценка промежуточной аттестации обучающихся производится по трём 

уровням: «высокий», «средний» и «низкий». 

Итоговая аттестация. Проводится после завершения всей учебной 

программы.  

- Форма итоговой аттестации: защита проекта, публичное выступление с 

демонстрацией результатов. В итоге реализации программы обучающиеся 

представляют проект на защиту (в разных формах),  

- Составление портфолио участия в конкурсных мероприятиях по профилю 

и мероприятиях побуждающих к социальной активности (волонтерская 

деятельность, организация мероприятий, просветительская работа и т.д).  

Оценка аттестационных мероприятий обучающихся производится по трём 

уровням: «высокий», «средний» и «низкий». 

Диагностика эффективности образовательного процесса осуществляется в 

течение всего срока реализации программы. Это помогает своевременно 

выявлять пробелы в знаниях, умениях обучающихся, планировать 

коррекционную работу, отслеживать динамику развития детей. Для оценки 

эффективности образовательной программы выбраны критерии, определяющие 

развитие интеллектуальных и технических способностей обучающихся: 

развитие памяти, воображения, образного, логического и технического 

мышления.  
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2.4. Оценочные материалы 

2.4.1.Входящая диагностика  

Анкетирование: 

1. «Что такое дизайн?» Напишите ответ своими словами. 

2. На листе белой бумаги изображены два объекта одинаковых размеров: 

тёмный и светлый. Какой из них привлечёт внимание первым?  

А) темный 

Б) светлый 

 

2.4.2.Текущая диагностика  

 

Тестирование к разделу № 2. «Основы скетчинга» 

Тест №1 

Выберите и отметьте правильные ответы: 

1. Что такое скетчинг?  

a) Процесс создания грубых набросков и зарисовок  

b) Метод работы с глиной  

c) Техника вышивания крестиком  

d) Изучение скоростных машин  

2. Для чего часто используется скетчинг?  

a) Для разработки идеи или концепции  

b) Для приготовления пищи  

c) Для обучения детей математике  

d) Для сбора монет  

3. Какие инструменты часто используются при скетчинге?  

a) Карандаши, маркеры, бумага  

b) Кисти, холст, масляные краски  

c) Лопатка, глина, гончарный круг  

d) Лупа, микроскоп, пинцет  

4. Что такое "thumbnail sketch"?  

a) Миниатюрный набросок для быстрого понимания композиции  

b) Эскиз для создания буклета  

c) Миниатюрный портрет  

d) Тренировочный рисунок для улучшения мелкой моторики  

5. Какая из следующих техник НЕ относится к скетчингу?  

a) Акварель  

b) Графика  

c) Скульптура  

d) Фотография  

 6. Что такое "gestural sketch"?  

a) Эмоциональный набросок, захватывающий живой движущийся объект  

b) Набросок для создания плана дома  

c) Художественный прием, включающий создание абстрактных форм  

d) Рисунок, изображающий только человеческие жесты  

7. Какой из следующих художников известен своими скетчами?  
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a) Леонардо да Винчи  

b) Пабло Пикассо  

c) Винсент Ван Гог  

d) Клауд Моне  

8. Какая основная цель скетчинга?  

a) Запутать зрителя  

b) Совершенствовать технику взмаха кисти  

c) Быстро передать идею или концепцию  

d) Создать полностью отшлифованное произведение  

9. Какой из следующих аспектов важен при скетчинге?  

a) Полное отсутствие ошибок  

b) Использование только черно-белых цветов  

c) Экспериментирование и не бояться ошибаться  

d) Избегание экспериментов  

10. Какую роль играет скетчинг в проектировании продуктов?  

a) Позволяет быстро визуализировать идеи и проводить 

концептуальные испытания  

b) Не играет никакой роли  

c) Только замедляет процесс  

d) Увеличивает стоимость проекта  

 

Ответы:  

1. a) Процесс создания грубых набросков и зарисовок  

2. a) Для разработки идеи или концепции  

3. a) Карандаши, маркеры, бумага  

4. a) Миниатюрный набросок для быстрого понимания композиции  

5. d) Фотография  

6. a) Эмоциональный набросок, захватывающий живой движущийся 

объект  

7. a) Леонардо да Винчи  

8. c) Быстро передать идею или концепцию  

9. c) Экспериментирование и не бояться ошибаться  

10.a) Позволяет быстро визуализировать идеи и проводить 

концептуальные испытания 

 

Тестирование к разделу № 2. «Основы скетчинга» 

Тест №2 

1. Какая комбинация клавиш используется для отмены 

последнего действия в Adobe Photoshop?  

a) Ctrl + Z  

b) Ctrl + Y  

c) Ctrl + X  

d) Ctrl + C  

Ответ: a) Ctrl + Z  
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2. Какая инструментальная панель предназначена для 

редактирования текста?  

a) Инструменты выделения  

b) Инструменты кисти  

c) Инструменты текста  

d) Инструменты рисования  

Ответ: c) Инструменты текста  

3. Какие типы файлов можно импортировать в Adobe Photoshop?  

a) Только изображения  

b) Только текстовые файлы  

c) Изображения, видео и аудиофайлы  

d) Только PDF-файлы  

Ответ: c) Изображения, видео и аудиофайлы  

 4. Какая команда используется для создания нового слоя в Adobe 

Photoshop?  

a) File > New  

b) Layer > New > Layer  

c) Edit > New Layer  

d) Ctrl + N  

Ответ: b) Layer > New > Layer  

5. Какая команда используется для изменения размера изображения в 

Adobe Photoshop?  

a) Image > Resize  

b) Edit > Transform > Scale  

c) File > Resize  

d) Ctrl + R  

Ответ: b) Edit > Transform > Scale  

6. Какой инструмент используется для выделения области 

изображения в форме прямоугольника?  

a) Инструмент "Прямая линия"  

b) Инструмент "Эллипс"  

c) Инструмент "Прямоугольник"  

d) Инструмент "Лассо"  

Ответ: c) Инструмент "Прямоугольник"  

7. Какая команда используется для наложения эффекта размытия на 

изображение в Adobe Photoshop?  

a) Filter > Blur  

b) Edit > Blur  

c) Image > Blur  

d) Ctrl + B  

Ответ: a) Filter > Blur  

  

8. Какая клавиша используется для активации инструмента "Кисть" 

в Adobe Photoshop?  

a) B  
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b) C  

c) P  

d) K  

Ответ: a) B  

  

9. Какой инструмент используется для увеличения или 

уменьшения масштаба изображения в Adobe Photoshop?  

a) Инструмент "Лассо"  

b) Инструмент "Прямоугольник"  

c) Инструмент "Рука"  

d) Инструмент "Масштаб"  

Ответ: d) Инструмент "Масштаб"  

  

10. Какая команда используется для сохранения файла в формате 

JPEG в Adobe Photoshop?  

a) File > Save As  

b) File > Export > Save for Web (Legacy)  

  c) File > Export > Export As  

  d) File > Save for Web (Legacy)  

 Ответ: b) File > Export > Save for Web (Legacy) 

 

Тестирование к разделу 3. «Основы 3d-моделирования (blender)» 

Тест №1 

 

1.Как создать новый проект в Blender 3D? 

a) Нажать Ctrl + N 

b) Выбрать File -> New 

c) Нажать Shift + A 

2.Как добавить объект в сцену Blender 3D? 

a) Нажать Shift + A 

b) Нажать Ctrl + C 

c) Нажать Tab 

3.Как изменить масштаб объекта в Blender 3D? 

a) Нажать S 

b) Нажать R 

c) Нажать G 

4.Как добавить материал к объекту в Blender 3D? 

a) Нажать M 

b) Нажать E 

c) Нажать Shift + N 

5.Как создать анимацию в Blender 3D? 

a) Нажать Alt + A 

b) Нажать Shift + A 

c) Нажать Ctrl + L 

6.Как сохранить проект в Blender 3D? 
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a) Нажать Ctrl + S 

b) Нажать Ctrl + C 

c) Нажать Ctrl + P 

7.Как добавить текстуру к объекту в Blender 3D? 

a) Нажать Shift + T 

b) Нажать Alt + T 

c) Нажать Ctrl + T 

8.Как создать рендер изображения в Blender 3D? 

a) Нажать Alt + R 

b) Нажать Ctrl + F 

c) Нажать F12 

9. Выберите интерфейс программы Blender 

А) 

 
В) 

  
 

Ответы: 

1. b) Выбрать File -> New 

2. a) Нажать Shift + A 

3. a) Нажать S 

4. c) Нажать Shift + N 

5. a) Нажать Alt + A 

6. a) Нажать Ctrl + S 

7. c) Нажать Ctrl + T 

8. c) Нажать F12 

9. а) 1 изображение 

 

Тест №2 

1. Что такое 3D моделирование? 

A. Процесс создания реалистичных трехмерных изображений 

B. Программа для создания двухмерных изображений 
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C. Технология для создания виртуальной реальности 

2. Какие программы используют для 3D моделирования? 

A. AutoCAD 

B. Blender 

C. Microsoft Word 

3. Для чего применяется 3D моделирование? 

A. Создание анимационных фильмов 

B. Дизайн промышленных изделий 

C. Разработка новых игр 

4. Какие типы 3D моделей существуют? 

A. Солидные и поверхностные 

B. Статические и динамические 

C. 2D и 3D 

5. Что такое текстурирование в 3D моделировании? 

A. Процесс добавления цветов и текстур на поверхность модели 

B. Создание анимации модели 

C. Изменение размера модели 

6. Какие проблемы могут возникнуть при 3D моделировании? 

A. Перегрев компьютера 

B. Недостаток оперативной памяти 

C. Неудачный выбор лайтбокса 

7. Что такое рендеринг в 3D моделировании? 

A. Процесс превращения 3D модели в 2D изображение 

B. Создание анимации модели 

C. Использование шумовых эффектов 

8. Какие форматы файлов можно использовать для сохранения 3D 

моделей? 

A. .obj 

B. .txt 

C. .jpg 

9. Какие инструменты используют для создания 3D моделей? 

A. Кисти и карандаши 

B. 3D сканеры и CAD программы 

C. Фотошоп и Иллюстратор 

10. Какие отрасли применяют 3D моделирование? 

A. Медицина и архитектура 

B. Музыка и искусство 

C. Парикмахерское дело и строительство 
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Ответы:  

1. A. Процесс создания реалистичных трехмерных изображений 

2. B. Blender 

3. C. Разработка новых игр 

4. B. Статические и динамические 

5. A. Процесс добавления цветов и текстур на поверхность модели 

6. B. Недостаток оперативной памяти 

7. A. Процесс превращения 3D модели в 2D изображение 

8. A. .obj 
9. B. 3D сканеры и CAD программы 

10. A. Медицина и архитектура 
  

Тестирование к разделу № 4 «Работа в программе КОМПАС 3D»  

 

1)Что такое копирование?  

2) Как выполняется копирование объекта при операции массив по 

концентрической сетке?  

3) Как влияет выбор оси на конечное изображение при выборе операции 

массив по концентрической сетке? 

 4) Выполните твердотельное моделирование детали представленной на 

рисунке ниже. 

 
 

 

2.4.3. Итоговая диагностика  

Выделите правильный ответы в следующих вопросах: 

 

1. Что такое цветовая гамма? 

A. Набор цветов, используемых в дизайне. 

B. Часть текста, выделенная определенным цветом. 

C. Техника создания объема на изображении 

2. Какой тип шрифта удобнее для чтения на экране? 

A. Шрифты с засечками. 
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B. Шрифты без засечек. 

C. Рукописные шрифты. 

3. Что такое баланс в дизайне?  

Равномерное распределение элементов на макете  

 Соответствие между цветами и формами  

 Использование симметрии в композиции 

4. Какой инструмент используется для создания векторных 

изображений?  

А.Adobe Photoshop 

В.Adobe Illustrator  

С.CorelDRAW 

5.Что такое белое пространство в дизайне?  

А. Незаполненное пространство в композиции  

В. Цвет, который соответствует белому  

С.Техника создания объема на изображении. 

6. Как называется использование различных текстур в дизайне?  

А. Коллаж  

В. Градиент  

С. Текстуринг 

8. Какой цвет является основным в цветовом колесе RGB? 

A. Красный  

B. Зеленый  

C. Синий 

9. Что такое макет в дизайне?  

А. Имя для файла с дизайном  

В. Предварительное изображение проекта  

С. Структурированное расположение элементов на документе 

10. Какой инструмент используется для редактирования 

цифровых изображений и фотографий?  

А. Adobe Illustrator  

В. Adobe Lightroom  

С. Adobe InDesign 

11. Что такое пантоновский цвет?  

А. Цвет из цветового колеса RGB  

В. Стандартный цвет, который можно точно воспроизвести  

С. Цвет, который воспроизводится только на пантоновской палитре 

12. Какой элемент дизайна используется для привлечения 

внимания к важной информации?  

A. Цветные акценты  

B. Растянутые шрифты  

C. Градиентные фоны 

13. Что такое типографика в дизайне?  

А. Исследование цветовых сочетаний  

В. Искусство оформления текста на изображении  

С. Создание композиции из различных текстур 
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14. Какой формат изображения лучше для сохранения фотографий с 

прозрачным фоном?  

А. JPEG  

В. PNG  

С. GIF 

15. Что такое аналоговая гармония цветов?  

А. Комбинация цветов, находящихся рядом в цветовом колесе  

В. Использование контрастных цветов  

С. Создание монохромных композиций 

 

Ответы:  

1. A. Набор цветов, используемых в дизайне 

2. A. Шрифты с засечками 

3. A. Равномерное распределение элементов на макете 

4. B. Adobe Illustrator 

5. A. Незаполненное пространство в композиции 

5. A. Коллаж 

6. B. Способ разделения пространства на пропорциональные части 

7. C. Синий 

8. C. Структурированное расположение элементов на документе 

9. B. Adobe Lightroom 

10. B. Стандартный цвет, который можно точно воспроизвести 

11. A. Цветные акценты 

12. B. Искусство оформления текста на изображении 

13. B. PNG 

14.A. Комбинация цветов, находящихся рядом в цветовом колесе 

 

 

2.4.4. Критерии оценки результативности презентации и защиты 

проекта. 
 Низкий Средний Высокий 

Оригиналь-

ность темы и 

идеи проекта 

Тема не актуальна и не 

соответствует 

возрастным 

особенностям и 

полученным 

программным знаниям. 

Нет плана работы над 

проектом, программа 

примитивна и 

выполнена небрежно 

Тема проекта 

недостаточно актуальна 

и значима, но творчески 

интересна. Знает порядок 

проведения 

исследования, имеет 

план работы над 

проектом 

Выбор актуальной 

темы проекта, его 

логическое 

обоснование, наличие 

плана работы по 

выполнению проекта 

Техническое 

решение 

Слабое владение 

основными 

лабораторными 

методиками/навыкам и 

работы с 

оборудованием. 

Достаточно владеет 

основными 

лабораторными 

методиками/ навыками 

работы с оборудованием, 

иногда с помощью 

В высокой степени, 

владеет основными 

лабораторными 

методиками/ 

навыками работы с 

оборудованием в 
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Избегает употреблять 

специальные термины. 

В состоянии выполнять 

лишь простейшие 

практические задания 

педагога. 

педагога. 

Сочетает специальную 

терминологию с 

бытовой. Выполняет 

задания самостоятельно 

основном 

самостоятельно, не 

испытывая особых 

трудностей. 

Демонстрирует 

уверенное владение 

понятийным 

аппаратом. 

Выполняет 

практические задания 

с элементами 

творчества 

Защита 

проекта 

Неясные 

умозаключения, 

неумение рассказать о 

результатах разработки 

Рассказывает о 

проведённом 

исследовании, но не 

умеет отвечать на 

вопросы 

В четкой логической 

последовательности 

излагает мысли, 

анализирует 

информацию и 

отстаивает свою 

точку зрения 

Проявляемый 

интерес к 

занятиям, 

творческая 

активность 

Минимальный интерес. 

Безынициативен, 

работает сам по себе, 

замечания принимает 

враждебно, всегда 

предъявляет претензии, 

отсутствует 

коммуникативный 

опыт защиты проекта 

Интерес стабильный. 

Недостаточно 

инициативен в 

совместном творчестве, 

присутствует 

дружелюбность в 

общении с товарищами, 

присутствует 

ответственность за 

общее дело, деловитость, 

не достаточно полно 

согласует свои действия 

с действиями команды 

Бесконфликтно и 

инициативно работает 

в команде, 

эффективно 

распределяются 

обязанности внутри 

команды. Участие в 

соревнованиях и 

фестивалях 

 

2.5. Методические материалы 

В ходе реализации программы используются методические пособия, 

разработанные преподавателем с учётом конкретных задач, упражнения, 

варианты демонстрационных программ, материалы по терминологии ПО, 

инструкции по настройке оборудования, учебная и техническая литература. 

Используются педагогические технологии индивидуализации обучения и 

коллективной деятельности.  

Программное обеспечение: Blender 3D, КОМПАС 3D, Adobe Photoshop, , 

PowerPoint. 

Учебно-методические материалы: 

 специализированная литература, подборка видеоматериала; 

 кейсовые задания к ряду разделов программы для постановки задачи и 

мотивации детей к деятельности в рамках изучения нового материала и 

отработки навыков; 

 наборы технической документации к применяемому оборудованию; 
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 образцы моделей, работ, разработок и систем, выполненные 

обучающимися и педагогом; 

 фото и видеоматериалы; 

 учебно-методические пособия для педагога и обучающихся, включающие 

дидактический, информационный, справочный материалы на различных 

носителях, компьютерное и видео оборудование. 

 

Подборка видеоуроков по программе: 

https://rutube.ru/video/d1f991bf47e422886f804a0b3b080010/ 

https://rutube.ru/video/095b3c9b3a5142ebb1ab147535446aeb/ 

https://rutube.ru/video/1076a5b417148838a7d50fc8c3ec487d/?r=a 

https://rutube.ru/video/045f2ef6b77204501df9eaa6cda41460/?ysclid=lvb8t42173584

616893 

https://rutube.ru/video/39f5e8fc811e648427fe08c8b30c01e8/?ysclid=lvb85yirwd390

244954 

https://rutube.ru/video/dc4cfcc9ce75f57f3e0a37b8ed1876b0/?ysclid=lvb80a28dd758

526651 

https://rutube.ru/video/6f6b932a94ecbd270351acccb9a34c86/?ysclid=lvb846hi52628

635509 

 

Применяемое на занятиях дидактическое и учебно-методическое 

обеспечение включает в себя электронные учебники, справочные материалы и 

системы используемых программ, Интернет. 

 

2.6. Воспитательный модуль. 

Воспитательная работа в рамках реализации программы «Основы 

промышленного дизайна» строится на основе «Программы воспитания в 

детском технопарке «Кванториум» (далее «Программа воспитания»), цель 

которой - создание единого воспитательного пространства учреждения для 

развития, саморазвития и самореализации личности обучающегося, социально 

мобильной и востребованной в современном обществе. 

Воспитательный компонент программы выстроен, исходя из основной 

идеи «Программы воспитания», способствующей созданию условий для 

формирования у обучающихся жизненно необходимых компетенций и 

вовлекает их в многогранную познавательную и творческую деятельность, 

создавая условия для самовыражения и самоутверждения.  

Все блоки и разделы программы включают в себя воспитательные задачи, 

которые призваны помочь всем участникам образовательного процесса 

реализовать воспитательный потенциал совместной деятельности.  

В содержательную часть воспитательного модуля заложена интегративная 

модель взаимодействия воспитательного и предметного компонента 

программы.  
В воспитательном модуле программы определены личностные результаты и 

контрольные мероприятия, в итоге реализации которых будут достигнуты планируемые 

личностные результатов обучающихся.  

https://rutube.ru/video/d1f991bf47e422886f804a0b3b080010/
https://rutube.ru/video/095b3c9b3a5142ebb1ab147535446aeb/
https://rutube.ru/video/1076a5b417148838a7d50fc8c3ec487d/?r=a
https://rutube.ru/video/045f2ef6b77204501df9eaa6cda41460/?ysclid=lvb8t42173584616893
https://rutube.ru/video/045f2ef6b77204501df9eaa6cda41460/?ysclid=lvb8t42173584616893
https://rutube.ru/video/39f5e8fc811e648427fe08c8b30c01e8/?ysclid=lvb85yirwd390244954
https://rutube.ru/video/39f5e8fc811e648427fe08c8b30c01e8/?ysclid=lvb85yirwd390244954
https://rutube.ru/video/dc4cfcc9ce75f57f3e0a37b8ed1876b0/?ysclid=lvb80a28dd758526651
https://rutube.ru/video/dc4cfcc9ce75f57f3e0a37b8ed1876b0/?ysclid=lvb80a28dd758526651
https://rutube.ru/video/6f6b932a94ecbd270351acccb9a34c86/?ysclid=lvb846hi52628635509
https://rutube.ru/video/6f6b932a94ecbd270351acccb9a34c86/?ysclid=lvb846hi52628635509
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1.6.1. Содержательная часть воспитательного компонента в процессе 

реализации учебного материала 
№

п/п 

Тематика 

занятия 

Воспитательный компонент 

1.  Знакомство, 

командообразова

ние, инструктаж, 

знакомство с 

оборудованием 

Безопасное поведение в кабинете, формирование навыка организации 

рабочего места и соблюдение правил ТБ, установление доверительных 

отношений между педагогом и обучающимися.  

Воспитание ценностного отношения к своему здоровью и здоровью 

окружающих.  

Развитие коммуникативных навыков, умение работать в команде. 

2.  Знакомство с 

дизайном. 

Формирование 

идеи.Создание 

макета на основе 

идеи 

Формирование уважительного отношения к товарищам, к педагогу. 

Установление доверительных отношений между педагогом и 

обучающимися, формирование навыка организации рабочего места и 

соблюдение правил ТБ. 

3.  Изучение основ 

скетчинга 

процессе 

Формирование основ научного мировоззрения, усвоение 

определенного объема научных знаний в области 3Д моделирования. 

Закрепление навыка организации рабочего места и соблюдение 

правил ТБ, установление доверительных отношений между педагогом 

и обучающимися. 

4.  
Изучение основ 

скетчинга и 

эскизирования 

Закрепление умения работать самостоятельно, решая задания и 

конструируя и программируя по инструкции. Формирование умения 

мобилизовать внутренние ресурсы для выполнения заданий.  

 

5.  

Построение 

перспективы на 

бумаге 

Воспитание основ коммуникативных отношений внутри проектных 

групп и в коллективе в целом.  

Включение в занятие интеллектуальной викторины, как игровой 

процедуры, которая помогает налаживанию позитивных 

межличностных отношений в группе. 

6.  

Объём. 

Передача объёма 

на бумаге. 

Формирование умения публичных выступлений.  

Создание ситуации успеха ребенка. 

Формирование умения вносить изменения в проект после 

консультации с экспертом.  

Воспитание уважительного отношения к работам других команд и 

обучающихся. 

7.  Материалы. 

Передача 

материалов на 

бумаге. 

Формирование навыка умения работать самостоятельно 

ответственности, самоорганизации, дисциплинированности.  

Умение работать с информацией в сети Интернет (поиск, подбор, 

выбор). 

8.  

Построение 

перспективы в 

Adobe Photoshop 

Использование приемов геймификации, при выполнении работы в 

командах, как процедуры, помогающей поддержать мотивацию детей 

к получению знаний.  

Совершенствование умения адекватно оценивать и представлять 

результаты совместной или индивидуальной деятельности в 

процессе создания проекта. 

9.  Объём. 

Передача объёма 

в Adobe 

Photoshop 

Формирование умения работать самостоятельно, решая поставленную 

задачу, воспитание уважительного отношения к работам других 

команд и обучающихся. Формирование основ коммуникативных 

отношений внутри проектных групп и в коллективе в целом. 
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10.  
Материалы. 

Передача 

материалов в 

Adobe Photoshop 

Формирование умения работать самостоятельно, решая поставленную 

задачу, воспитание уважительного отношения к работам других 

команд и обучающихся. 

Формирование основ коммуникативных отношений внутри проектных 

групп и в коллективе в целом. 

11.  Принципы 

создания 3d-

моделей, виды 

3d-

моделирования 

Формирование умения работать самостоятельно, решая поставленную 

задачу, воспитание уважительного отношения к работам других 

команд и обучающихся. 

Формирование основ коммуникативных отношений внутри проектных 

групп и в коллективе в целом. 

12.  Знакомство с 

blender  

Формирование умения публичных выступлений.  

Создание ситуации успеха ребенка. 

Формирование умения вносить изменения в проект после 

консультации с экспертом.  

Воспитание уважительного отношения к работам других команд и 

обучающихся. 

13.  Создание 

простых фигур в 

Blender 

Формирование навыка умения работать самостоятельно.  

Викторина о безопасности в сети интернет. 

 Умение работать с информацией в сети Интернет (поиск, подбор, 

выбор). 

Закрепление умения работать самостоятельно внутри проектных 

групп и в коллективе в целом добросовестно и творчески подходя к 

разным видам деятельности. 

14.  Работа с 

материалами и 

текстурами 

Умение работать с информацией в сети Интернет(поиск, подбор, 

выбор). Формирование навыка генерирования и оформления 

собственных идей в рамках реализации групповых исследовательских 

проектов, формирование и закрепление навыка работы в команде для 

решения поставленной проблемы. 

15.  Моделирование 

промдизайнкван

тума Постановка 

задачи и 

актуализация 

знаний 

Инициирование исследовательской деятельности в рамках реализации 

ими групповых исследовательских и инженерных проектов, 

формирование и закрепление навыка работы в команде. 

Воспитание чувства коллективизма, взаимопомощи, уважения к 

творческому труду. 

16.  Работа над 

кейсовым 

заданием 

Поддержка исследовательской деятельности обучающихся, 

закрепление навыка работать в команде. Формирование навыка 

самостоятельной работы и доведение начатого до конца.  

17.  Постановка 

задачи и 

актуализация 

знаний в blender 

Поддержка исследовательской деятельности обучающихся, 

закрепление навыка работать в команде. Формирование навыка 

самостоятельной работы и доведение начатого до конца. 

Поддержка исследовательской деятельности обучающихся в рамках 

реализации проектов, закрепление навыка работы в команде. 

18.  Работа над 

кейсовым 

заданием 

Поддержка исследовательской деятельности обучающихся, 

закрепление навыка работать в команде. Формирование навыка 

самостоятельной работы и доведение начатого до конца. Воспитание 

ответственности, самоорганизации, дисциплинированности. 

19.  Основы 3D-

моделирования. 

Интерфейс 

программы 

КОМПАС 

Совершенствование умения адекватно оценивать и представлять 

результаты совместной или индивидуальной деятельности в 

процессе создания проекта. 

Закрепление умения работать самостоятельно, решая задания, 

конструируя и программируя. 

Формирование умения анализировать сделанное и умения вносить 
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коррективы. мобилизовать внутренние ресурсы для выполнения 

заданий. 

20.  Построение 

сложные 

чертежей 

деталей 3х видов 

Поддержка исследовательской деятельности обучающихся, 

закрепление навыка работать в команде. Формирование умения 

вносить изменения в проект после консультации с экспертом.  

Воспитание уважительного отношения к работам других команд и 

обучающихся. 

21.  Практическая 

работа  

Формирование навыка умения работать самостоятельно.  

Викторина о безопасности в сети интернет. 

 Умение работать с информацией в сети Интернет (поиск, подбор, 

выбор). 

Воспитание чувства патриотизма, гражданственности, гордости за 

достижения отечественной науки и техники. Закрепление умения 

работать самостоятельно внутри проектных групп и в коллективе в 

целом добросовестно и творчески подходя к разным видам 

деятельности. 

22.  Постановка 

задачи и 

актуализация 

знаний 

PhotoShop 

Способствовать повышению заинтересованности подрастающего 

поколения в научных познаниях об устройстве мира и общества.  

Формирование навыков соблюдения на занятии общепринятых нормы 

поведения, учебной дисциплины и самоорганизации в процессе 

работы. 

Развитие навыков совместной работы и умения правильно оценивать 

смысл и последствия своих действий. 

23.  Постановка 

задачи и 

актуализация 

знаний 

PhotoShop 

Формирование навыка генерирования и оформления собственных 

идей в рамках реализации групповых исследовательских проектов, 

формирование и закрепление навыка работы в команде для решения 

поставленной проблемы.  

24.  Решение кейса Формирование умения работать самостоятельно, проявлять терпение 

и настойчивость. Совершенствование умения адекватно оценивать и 

представлять результаты совместной или индивидуальной 

деятельности в процессе создания проекта. 

25.  Создание 

чертежа модели 

в КОМПАС 

Инициирование исследовательской деятельности в рамках реализации 

ими групповых исследовательских и инженерных проектов, 

формирование и закрепление навыка работы в команде. 

26.  Создание 

чертежа модели 

в КОМПАС 

Инициирование исследовательской деятельности в рамках реализации 

ими групповых исследовательских и инженерных проектов, 

формирование и закрепление навыка работы в команде. 

Воспитание чувства коллективизма, взаимопомощи, уважения к 

творческому труду. 

27.  Работа с 3D 

печатью 

Проведение игры, помогающей поддержать мотивацию детей к 

получению знаний. 

Формирование умения работать самостоятельно, решая поставленную 

задачу, воспитание уважительного отношения к работам других 

команд и обучающихся. 

28.  Настройка 

взаимодействия 

c объектами 

Совершенствование умения адекватно оценивать и представлять 

результаты совместной или индивидуальной деятельности в 

процессе создания проекта. 

29.  Тестирование и 

отладка 

приложения 

Поддержка исследовательской деятельности обучающихся, 

закрепление навыка работать в команде. Совершенствование умения 

адекватно оценивать и представлять результаты совместной или 

индивидуальной деятельности в процессе создания проекта. 
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Закрепление умения работать самостоятельно, решая задания и 

конструируя, и программируя по инструкции. 

30.  Итоговая защита 

проектов.  

Открытая защита с приглашением экспертов и родителей. 

Формирование умения мобилизовать внутренние ресурсы для 

выполнения заданий. 

Создание у обучающихся ситуации успеха.  

Отработка навыка публичного выступления перед аудиторией, 

аргументирования и отстаивания своей точки зрения. Отработка 

умения публичных выступлений.  

 

 

1.6.2. План воспитательной работы вне учебных занятий.  
№ Мероприятие Воспитательный компонент 

Участие в конкурсных мероприятиях регионального, федерального уровня по профилю 

1 Региональный конкурс  

«3D игрушка» 

Приобретение опыта участия в конкурсных мероприятиях. 

Формирование мотивации к участию в конкурсных 

мероприятиях. Закрепление навыка публичной презентации 

проекта, командного взаимодействия. 

2 Региональный этап 

всероссийского конкурса 

научно-технического и 

инновационного 

творчества 

«Ш.У.С.Т.Р.И.К.» 

Приобретение опыта участия в конкурсных мероприятиях. 

Формирование мотивации к обучению по программе. 

Формирование умения оформлять презентационные и 

исследовательские материалы по проекту. Закрепление навыка 

публичной презентации проекта, командного взаимодействия. 

3 Областной фестиваль 

технических и 

естественно-научных 

проектов  

«Матрица идей-2024» 

Приобретение опыта участия в конкурсных мероприятиях. 

Формирование мотивации к участию в конкурсных 

мероприятиях. Закрепление навыка публичной презентации 

проекта, командного взаимодействия. 

6 XVII Конкурс научно-

исследовательских и 

творческих работ 

«Нобелевские надежда 

КНИТУ-2024» 

Приобретение опыта участия в конкурсных мероприятиях. 

Формирование мотивации к обучению по программе. 

Формирование умения оформлять презентационные и 

исследовательские материалы по проекту. Закрепление навыка 

публичной презентации проекта, командного взаимодействия. 

8 Всероссийский конкурс 

медиатворчества и 

программирования «24bit» 

в рамках Всероссийского 

открытого фестиваля 

научно технического 

творчества Траектория 

технической мысли 2024 

Приобретение опыта участия в конкурсных мероприятиях. 

Формирование мотивации к участию в конкурсных 

мероприятиях. Закрепление навыка публичной презентации 

проекта, командного взаимодействия 

9 Всероссийский конкурс 

проектов 3D 

моделирования и 3D 

печати «Перспектива 3D» 

Приобретение опыта участия в конкурсных мероприятиях. 

Формирование мотивации к обучению по программе. 

Формирование умения оформлять презентационные и 

исследовательские материалы по проекту. Закрепление навыка 

публичной презентации проекта, командного взаимодействия. 

Конкурсные командные профильные мероприятия. 

10 Интеллектуальные 

межквантумные игры 

«Технологии будущего» 

Развитие интереса к информационным технологиям, содействие 

профессиональной ориентации обучающихся. Формирование 

умения мобилизовать внутренние ресурсы на решение 
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поставленных задач в условиях ограниченного времени. 

11 IT-хакатон Формирование умения мобилизовать внутренние ресурсы на 

решение поставленных задач в условиях ограниченного времени. 

Формирование мотивации к участию в конкурсных 

мероприятиях. Закрепление навыка публичной презентации 

проекта, командного взаимодействия. 

12 Образовательное 

мероприятие «Кванто-

Хакатон» 

Формирование умения мобилизовать внутренние ресурсы на 

решение поставленных задач в условиях ограниченного времени. 

13 Внутриквантовая игра на 

генерацию идей 

«ВСмысле».  

Игра на формирование навыка генерирования и оформления 

собственных идей в рамках реализации ими групповых 

исследовательских проектов, формирование и закрепление 

навыка работы в команде для решения поставленной проблемы. 

Модуль «Самоопределение» 

14 Экскурсия на предприятие 

ООО «ДПЗ» 

Знакомство с предприятиями города, на которых используются 

технологии, изучаемые в программе, содействие 

профессиональному самоопределению. 

Знакомство с возможностями современного пружинного 

производства и места специалистов IT на нем. Воспитание у 

детей уважения к труду и людям труда, трудовым достижениям. 

15 Экскурсии на 

предприятие ООО 

«Торсион». 

Знакомство с предприятиями города, на которых используются 

технологии, изучаемые в программе, содействие 

профессиональному самоопределению. 

Воспитание у детей уважения к труду и людям труда, трудовым 

достижениям. Знакомство с возможностями современного 

производства, работа специалистов IT по разработке 

мониторинга производственных процессов.. 

16 Экскурсия в музей ГНЦ 

НИИАР  

Знакомство с предприятиями города, на которых используются 

технологии, изучаемые в программе, содействие 

профессиональному самоопределению. Знакомство с 

возможностями научно исследовательского института атомных 

реакторов, мониторинга систем атомной отрасли и места 

специалистов IT на нем. 

17 Профориентационный 

квест «Будующее рядом с 

тобой» 

Формирование представлений о профессии, создание условия 

для раскрытия потенциала каждого ребёнка. 

Модуль «Наставничество» 

18 Занятие с внешним 

спикером Щютц В.А 

директор ООО «Торсион». 

Востребованность на 

современном 

производстве 

специалистов владеющих 

3Д моделированием. 

Знакомство с представителями профессий в сфере IT-

технологий. Формирование представлений о будущей 

профессии. Воспитание у детей уважения к труду и людям 

труда, трудовым достижениям. 

19  Занятие с внешним 

спикером преподавателем 

ДИТИ НИЯУ МИФИ 

Погляд С.В., особенности 

обучения специальностям 

Создание условий для получения детьми достоверной 

информации о передовых достижениях и открытиях мировой и 

отечественной науки, повышения заинтересованности 

подрастающего поколения в научных познаниях об устройстве 

мира и общества. Формирование представлений о будущей 
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IT сферы. профессии. 

20 Занятие с внешним 

спикером Летуновским, 

директором ЦМИТ 

«Прогрес». Особенности 

проектов с 

использованием AR/VR 

Создание условий для получения детьми достоверной 

информации о передовых достижениях и открытиях мировой и 

отечественной науки, повышения заинтересованности 

подрастающего поколения в научных познаниях об устройстве 

мира и общества. Формирование представлений о будущей 

профессии. 

21 «Дети детям» (Kids for 

kids) 

Освоение коммуникативной компетенции; Формирование 

способов социальной активности, навыка самостоятельного 

решения социальных задач, навыков поведения в различных 

жизненных ситуациях. Умение ориентироваться в социуме, 

взаимодействовать со сверстниками в роли наставника.  

Модуль. «Работа с родителями» 

22 Родительские собрания 

 

Общие собрания организации (по отдельному плану); 

Профильные по плану организации (встречи со специалистами 

ВУЗов, СУЗов, предприятий); 

Внутригрупповые - обсуждение проблем обучения и воспитания, 

достижений и результатов обучения обучающихся. 

23 Взаимодействие с 

родителями онлайн 

С помощью своевременного и систематического размещения 

информации в родительском чате, в социальной сети, на сайте 

учреждения 

24 Индивидуальная работа с 

родителями 

Помощь со стороны родителей в подготовке к конкурсным и 

олимпиадным мероприятиям 

25 Индивидуальное 

консультирование 

родителей 

Тематика по запросу родителей: 

Профориентация, особенности психофизиологического 

развития, индивидуальные успехи, рекомендации.. 

 

2.7.Список литературы 

 

Список литературы для педагога:  

 

1. Барзиловский А. Б., Симоненко В. Д. Основы технического творчества. 

Учебник для учащихся 5–9 классов общеобразовательных учреждений. – М.: 

Вентана-Граф, 2017. 

2. Кузина Е. В. Технология. Дизайн. 5 класс: учеб. для общеобразоват. 

организаций / Е. В. Кузина, Г. П. Самойлова, О. А. Рыдзе. — М.: Просвещение, 

2018. 

3. Самойлова Г. П. Технология. Дизайн. 6 класс: учеб. для общеобразоват. 

организаций / Г. П. Самойлова, Е. В. Кузина, О. А. Рыдзе. — М.: Просвещение, 

2018. 

4. Самойлова Г. П. Технология. Дизайн. 7 класс: учеб. для общеобразоват. 

организаций / Г. П. Самойлова, Е. В. Кузина, О. А. Рыдзе. — М.: Просвещение, 

2018. 

5. Самойлова Г. П. Технология. Дизайн. 8 класс: учеб. для общеобразоват. 

организаций / Г. П. Самойлова, Е. В. Кузина, О. А. Рыдзе. — М.: Просвещение, 

2018. 
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6. Самойлова Г. П. Технология. Дизайн. 9 класс: учеб. для общеобразоват. 

организаций / Г. П. Самойлова, Е. В. Кузина, О. А. Рыдзе. — М.: Просвещение, 

2018.  

7. «Дизайн вещей». Авторы: Джонатан Ив и Игорь Адамович. 

8. «Дизайн для реального мира». Автор: Виктор Папанек. 

9. «Дизайн-мышление в бизнесе». Автор: Жанна Лидтка и Тим Огилви. 

10. «Промышленный дизайн. История в 100 вещах». Автор: Джеймс 

Уорд. 

11.«Язык шаблонов». Авторы: Кристофер Александер, Сэр Эндрю 

Уилсон, Майкл Сильверштейн, Бернард Рэмси, Дональд Аппельбаум. 

 

Список литературы для обучающихся: 

 

1.Браиловская Л.В. «Арт-Дизайн: красивые вещи hand-made », «Феникс», 

2005. 

«120 способов изображения». Москва «РОСМЕН», 2003. 

2.Холмянский Л.М., Щипанов А.С. «Дизайн: Книга для учащихся». – М.: 

Просвещение, 1985. 

3.Флеминг.Б. «Фотореализм. Профессиональные приемы работы». ДМК, 

2000г. 

4.Флеминг.Б. «Текстурирование трехмерных объектов». - ДМК, 2004 г. 

 

Список литературы для родителей: 

1.Фил Кливер.Чему вас не научат в дизайн-школе /Рипол Классик. 

2.МайклДжанда. Сожги своё портфолио! То,чему не учат в дизайнерских 

школах /Питер. 

3.Жанна Лидтка, Тим Огилви. Думай как дизайнер. Дизайн-мышление для 

менеджеров /Манн, Иванов и Фербер. 

4.Браиловская Л.В. «Арт-Дизайн: красивые вещи hand-made », «Феникс», 

2005. 

«120 способов изображения». Москва «РОСМЕН», 2003. 

5.Холмянский Л.М., Щипанов А.С. «Дизайн: Книга для учащихся». – М.: 

Просвещение, 1985. 

6.Флеминг.Б. «Фотореализм. Профессиональные приемы работы». - ДМК, 

2000г. 

7.Флеминг.Б. «Текстурирование трехмерных объектов». - ДМК, 2004 г. 

 

Электронные ресурсы:  

https://portal.tpu.ru/SHARED/k/KUHTA/len/Tab1/Tab/pd.pdf 

https://vk.com/doc-

69769644_430404157?hash=aMbrhLlvfHsQQNGXdgswZ7iM0JW9JTr44ZSX3hvz

ByP&dl=yjTI2HavOUOqtyEsFlsTkL8WmSachMyRIXJcpGPvtpz 

https://vk.com/doc-

69769644_430406008?hash=VuUiH0ayC0EQh5Ff4TrxgC09ZlMzHZb0xZMTeptCp

Vz&dl=z53bfeoBLq9Q9rH65UdSvFmL6T4rAfzZuzHuAOsfweH 

https://portal.tpu.ru/SHARED/k/KUHTA/len/Tab1/Tab/pd.pdf
https://vk.com/doc-69769644_430404157?hash=aMbrhLlvfHsQQNGXdgswZ7iM0JW9JTr44ZSX3hvzByP&dl=yjTI2HavOUOqtyEsFlsTkL8WmSachMyRIXJcpGPvtpz
https://vk.com/doc-69769644_430404157?hash=aMbrhLlvfHsQQNGXdgswZ7iM0JW9JTr44ZSX3hvzByP&dl=yjTI2HavOUOqtyEsFlsTkL8WmSachMyRIXJcpGPvtpz
https://vk.com/doc-69769644_430404157?hash=aMbrhLlvfHsQQNGXdgswZ7iM0JW9JTr44ZSX3hvzByP&dl=yjTI2HavOUOqtyEsFlsTkL8WmSachMyRIXJcpGPvtpz
https://vk.com/doc-69769644_430406008?hash=VuUiH0ayC0EQh5Ff4TrxgC09ZlMzHZb0xZMTeptCpVz&dl=z53bfeoBLq9Q9rH65UdSvFmL6T4rAfzZuzHuAOsfweH
https://vk.com/doc-69769644_430406008?hash=VuUiH0ayC0EQh5Ff4TrxgC09ZlMzHZb0xZMTeptCpVz&dl=z53bfeoBLq9Q9rH65UdSvFmL6T4rAfzZuzHuAOsfweH
https://vk.com/doc-69769644_430406008?hash=VuUiH0ayC0EQh5Ff4TrxgC09ZlMzHZb0xZMTeptCpVz&dl=z53bfeoBLq9Q9rH65UdSvFmL6T4rAfzZuzHuAOsfweH
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https://vk.com/doc-

69769644_430405613?hash=E9RgB59iNIysIPzA2TzcxQmpr1QyIE58US0IOemkzP

g&dl=1nZQs47oH9IMz0IzM99pck18GDUIACz2zrwLroybIzo 

https://vk.com/doc-

69769644_430406121?hash=4ymvYzZqCtZzJSnEOnnhNuVa8JhacibOggamcL2P0z

0&dl=ZHyxAvC7yeZCdUWBM7S8o6NSjX6opsu4zq86jZDTfPw 

https://vk.com/doc-

69769644_430403041?hash=r6tvxNCJSaSG9Gnl6GpfIH9Tc6t1zgsM2zocrl55cFw&

dl=LGuHakT03YQPAheno8WzMFpDgIzpKuizYLR57FIca9g 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://vk.com/doc-69769644_430405613?hash=E9RgB59iNIysIPzA2TzcxQmpr1QyIE58US0IOemkzPg&dl=1nZQs47oH9IMz0IzM99pck18GDUIACz2zrwLroybIzo
https://vk.com/doc-69769644_430405613?hash=E9RgB59iNIysIPzA2TzcxQmpr1QyIE58US0IOemkzPg&dl=1nZQs47oH9IMz0IzM99pck18GDUIACz2zrwLroybIzo
https://vk.com/doc-69769644_430405613?hash=E9RgB59iNIysIPzA2TzcxQmpr1QyIE58US0IOemkzPg&dl=1nZQs47oH9IMz0IzM99pck18GDUIACz2zrwLroybIzo
https://vk.com/doc-69769644_430406121?hash=4ymvYzZqCtZzJSnEOnnhNuVa8JhacibOggamcL2P0z0&dl=ZHyxAvC7yeZCdUWBM7S8o6NSjX6opsu4zq86jZDTfPw
https://vk.com/doc-69769644_430406121?hash=4ymvYzZqCtZzJSnEOnnhNuVa8JhacibOggamcL2P0z0&dl=ZHyxAvC7yeZCdUWBM7S8o6NSjX6opsu4zq86jZDTfPw
https://vk.com/doc-69769644_430406121?hash=4ymvYzZqCtZzJSnEOnnhNuVa8JhacibOggamcL2P0z0&dl=ZHyxAvC7yeZCdUWBM7S8o6NSjX6opsu4zq86jZDTfPw
https://vk.com/doc-69769644_430403041?hash=r6tvxNCJSaSG9Gnl6GpfIH9Tc6t1zgsM2zocrl55cFw&dl=LGuHakT03YQPAheno8WzMFpDgIzpKuizYLR57FIca9g
https://vk.com/doc-69769644_430403041?hash=r6tvxNCJSaSG9Gnl6GpfIH9Tc6t1zgsM2zocrl55cFw&dl=LGuHakT03YQPAheno8WzMFpDgIzpKuizYLR57FIca9g
https://vk.com/doc-69769644_430403041?hash=r6tvxNCJSaSG9Gnl6GpfIH9Tc6t1zgsM2zocrl55cFw&dl=LGuHakT03YQPAheno8WzMFpDgIzpKuizYLR57FIca9g
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